
 

Go to CGTech Help Library 
 
 
 
 
 
 

Installing CGTech Products 
 



 

 

VERICUT Installation 
 

Introduction to Installing VERICUT 
 

Installing and configuring VERICUT is simple, typically requiring only a few minutes 
for most installations. 

 

Overview 
A VERICUT installation involves adding VERICUT product files to your computer and 
setting-up licensing.  

Files are added to your computer with a typical "wizard" installation process, where you 
run an installer program which prompts you through various options in a sequence of 
screens, and ultimately adds VERICUT product files to your computer. 

VERICUT is a licensed program, meaning VERICUT requires authorization from 
another software program (the license server) before it can run. When VERICUT starts it 
communicates with the license server program, gets authorization to continue, and 
displays on your computer, ready to use. 

 

Terminology 
It is important you understand 3 terms frequently used throughout the installation 
instructions. 

License Server Program — The program providing licenses for VERICUT. 
VERICUT requires a license, thus the License Server Program must be running for 
VERICUT to operate. VERICUT uses the Sentinel RMS license server program from 
SafeNet. The license server program and VERICUT communicate using network 
protocols. Only one Sentinel RMS license server program may run on a computer. 

License Server Computer — The computer running the license server program. It 
may be the same computer running VERICUT, such as in a simple single computer 
installation. Or it may be a computer supplying licenses to other computers running 
VERICUT in your company’s network. 

Client Computer — The computer that runs VERICUT. 

Where you decide to put VERICUT product files depends on whether you have a simple 
single computer installation, or multiple networked computers. However, the License 
Server Computer and License Server Program are configured exactly the same for any 
type of installation, from a simple single computer to multiple networked computers with 
mixed Windows and UNIX Client Computers on a wide area network.  

http://www.safenet-inc.com/products/sentinel/Sentinel_RMS.asp


 

Important information regarding licensing  
You do not need to request a license for a major release (such as 6.0, 6.2, 7.0, etc) if 
you are currently running VERICUT and are current on software maintenance. CGTech 
automatically emails updated license keys to existing customers with current software 
maintenance when a new VERICUT major version is shipped. CGTech emails license 
keys to your company's primary VERICUT contact shortly before shipping VERICUT 
CDs.  

You also do not need to request a license if you have already received one specific for 
this major version and are installing a point release, such as 7.0.1. 

You must request a license for a new installation, to add new modules to an existing 
installation, to change license server computers, or to update to a new major version after 
renewing expired maintenance. If this is a new installation or if you are changing to a 
new license server computer, you need to tell CGTech the HOST ID of the license server 
computer. The HOST ID of your license server computer is determined during the 
installation steps below. 

 



 

 

Installation Steps 
Following are the sequence of steps required to successfully install VERICUT. Click on 
each link below for details on each step. At the bottom of each detail page is a link to the 
next step. 

 

Install VERICUT 
NOTE:  For best results follow the outline below in sequence. Each subsequent step 
relies on completion and/or information from the previous one. 

If errors occur, visit the VERICUT Users’ Forum  or contact CGTech technical support 
via our website, just click on the support link. 

 

1. Choose your installation configuration. 

2. Check VERICUT System Requirements and make sure that your system meets them. 

3. If this is a new installation or you do not already have a VERICUT 7.0 license, 
determine your license server computer HOST ID and request a VERICUT license. 

4. Install VERICUT on a stand-alone or License Server Computer: Windows or UNIX.  

5. Configure and start the license server: Windows or UNIX. 

6. Test VERICUT to verify correct operation and licensing on the License Server 
Computer: Windows or UNIX. 

7. If you have other computers that will access the same license server, configure and 
test VERICUT client computers, Windows or UNIX. 

Your VERICUT installation is now complete. 

 
Other VERICUT Configuration Tasks 
Following are configuration tasks that may need to be done depending on the CGTech 
products you are using. 

• To configure CAD/CAM Interface modules, go to one of the following:  

CATIA-to-VERICUT Interface (CATV) for CATIA version 4 

CATIA V5-to-VERICUT Interface for CATIA version 5 

EdgeCAM-to-VERICUT Interface 

http://cgtech.com/forum/
http://cgtech.com/


 

GibbsCam-to-VERICUT Interface (GibbsV) 

Mastercam-to-VERICUT Interface (MCAMV)  

NX-to-VERICUT Interface (NXV) 

• To install the CAD Model Interface modules, go to Installing the Model Interface 
Modules.  

• To configure the VERICUT TDM Interface, go to VERICUT TDM Systems 
Interface. 

 

Following are other configuration tasks that may need to be done, depending on your 
site's requirements. 

• Windows Start Menu License Administration Choices 

• Determine Your License Server's Host ID, Windows or UNIX 

• Check Network Configuration, Windows or UNIX 

• Mount a UNIX CD 

• Change License Servers, Windows or UNIX 

• Install VERICUT License Server Only 

• Update an Existing License, Windows or UNIX 

• Stop and Remove a License Server, Windows or UNIX 

• Starting a Temporary License Server, Windows or UNIX 

• Use Silent Install 

• Uninstall an old version of VERICUT 

• Download and Install the Latest Point Release for Windows 

• Running VERICUT 5.2 or 5.3 with the current VERICUT License Server 

• Installing Microsoft C++ redistributable run-time libraries for XP64 

• Configure Redundant License Servers on Windows or UNIX. 

 



 

 

1. Choose an Installation Configuration 
 

There are several different ways to configure your VERICUT installation. Following are 
three common configurations: a simple single computer or stand-alone installation and 
two different multiple-computer installations. 

 

Single Computer Installation 

 
 

• VERICUT is installed on this computer's local disk. 
• The license server program is running on this computer. 
• The license server program only supplies licenses to VERICUT running on 

this computer. 
 
Multiple Computer Installation 
 

 VERICUT and License Server  VERICUT    VERICUT 

 
 

• VERICUT is installed on each computer's local disk. 

• The license server program is running on one of the computers. 

• The license server program supplies licenses to VERICUT running on multiple 
computers on the network. 

  



 

Multiple Computer Network Installation 
 

VERICUT and License Server  (accesses VERICUT on network mounted disk) 

 
 

• VERICUT is installed on one computer's disk. The disk is mounted or mapped on 
all computers using the same path. 

• The license server program is running on one of the computers. 

• The license server program supplies licenses to VERICUT running on multiple 
computers on the network. 

There is always a license server computer in all three types of installations. The license 
server computer can be any computer on the network capable of running the license 
server program. The license server is installed and configured in exactly the same way 
regardless of the type of installation. The only difference between these installations is 
the client computer configuration. 

In the case of the "Single Stand-alone Computer" installation, the license server 
program and VERICUT both run on the same computer. The VERICUT client computer 
and the license server computer are the same computer. However, it is important to note 
that VERICUT and the license server program must still communicate with each other 
using network protocols, even thought they are on the same physical computer. 

The "Multiple Computer Installation" consists of one computer configured the same as 
the single stand-alone computer described above, but with additional VERICUT 
installations on other computers on the network, the VERICUT Client Computers. 
These client computers do not run the license server program, but rather communicate 
with the license server computer and request licenses from the license server program 
over the network. The communication protocol is TCP/IP. 

Finally, the "Multiple Computer Network Installation" is similar to the single stand-
alone configuration in that there is only one copy of VERICUT installed. In this case 
VERICUT is installed on a disk that is network mounted or mapped on one or more client 
computers. Generally the license server computer is the computer with the disk 
physically attached, but this is not necessary. The VERICUT client computers do not 
have VERICUT installed on a local disk. Instead they access VERICUT on a network 
mounted or mapped disk. The disk where VERICUT is installed must be mounted or 
mapped to exactly the same path on all the computers. Thus if VERICUT is installed on 



 

H:\CGTECH in a Windows environment, then all computers must map the disk with the 
same letter and path. 

The Multiple Computer Network Installation is the simplest installation to maintain 
for a medium to large corporate network environment since there is only one license 
server computer and one installation of VERICUT shared by all users. However it does 
require some custom configuration on each client (adding start menu or desktop 
shortcuts) in order to give users on the client computers easy access to VERICUT. This 
work is generally done by the site's system administrator. 

 

Next installation task: Check System Requirements 

 

Return to Installation Steps. 

 



 

 

2. Check VERICUT System Requirements 
Version 7.0 
 

IMPORTANT!   Always check the latest system requirements, available at VERICUT 
7.0 's Requirements webpage. 

 

NOTE:   Requirements have changed – review carefully 

 

General Requirements 

• CD-ROM drive  

• Two or three button mouse 

o Three button mouse with mouse-wheel is recommended due to dynamic 
view controls  

• Network interface card  

• Graphics device capable of displaying at least 16K colors  

• Hardware graphics accelerators can be used in a machine simulation view and for 
dynamic rotate/pan/zoom in a workpiece view. Due to the large amount of 
graphics memory required to display the cut stock, graphics memory of 128 MB 
minimum is recommended, and 256 MB is preferred.  

• Physical Memory: 512 MB Minimum, 1 GB recommended, 2 GB is preferred, 
especially when running VERICUT concurrent with another large program such 
as a CAD/CAM product. The Windows XP 64 bit operating system allows access 
to memory beyond the standard Windows 2 GB application limit.  

Windows and Windows XP64 Requirements  

Disk Space 500 Mb (full installation including Library, Samples, and Help files, and 
Java Run-Time) 

Temporary 
Disk Space 

300 Mb required during installation, in addition to the permanent Disk 
Space above. 

Page File 2-times available physical memory recommended 

Windows 
Operating 
System 

VERICUT works on Windows XP, Windows XP64, and Windows 2000. 
Click here for Vista status. 

VERICUT 7.0  is not supported on Windows 98, Windows ME and 

http://cgtech.com/usa/support/systemrequirements/
http://cgtech.com/usa/support/systemrequirements/
http://cgtech.com/forum/viewtopic.php?t=760


 

Windows NT operating systems. Click here for more information. 

Java Run Time Environment 1.5.0_06 (included in the VERICUT 
installation) 

Windows Script 5.3 or later is required for the CATIA V5 Interface 

TCP/IP Network Protocol installed on the network device 
  
VERICUT on Windows XP64 requires installation of Windows C++ run-
time libraries. An administrative user must do the installation. The run-time 
library installer is included on the VERICUT CD and in the downloadable 
zip file of the VERICUT installation. The installer file name is 
vcredist_x64.exe. Double-click on the file to run the installer.  

The library installer is also available for download at:  

ftp://ftp.cgtech.com/Download/pointrel/windows64/vcredist_x64.exe   

VERICUT 7.0 uses different run-time libraries than VERICUT 6.0 and 6.1. 

The different versions of run-time libraries can be installed together on the 
same computer if you need to run both 6.0/6.1 and 7.0 concurrently. 
  

Physical 
Memory  

512 MB Minimum, 1 GB recommended, 2 GB is preferred, especially when 
running VERICUT concurrent with another large program such as a 
CAD/CAM system. The Windows XP64 operating system allows access to 
memory beyond 32 bit Windows XP’s 2 GB application limit. 

Processor  Intel Pentium or 100% Pentium-compatible Processor. 

1 ghz or faster recommended. 
Dual processors improve performance, especially when running other large 
programs concurrently with VERICUT. 

 
 
UNIX Requirements 
Disk Space 

  
  
  
Temp Disk 
Space 
  
Swap 

500 Mb for the first UNIX platform (full installation including Library, 
Samples and Help files) 

30 Mb for each additional UNIX platform type 

300 Mb required during installation, in addition to the permanent Disk Space 
above 

2-times physical memory recommended 

http://cgtech.com/forum/viewtopic.php?t=213
ftp://ftp.cgtech.com/Download/pointrel/windows64/vcredist_x64.exe


 

Partition 

HP  

  

HP-UX 11.11 plus required patches 

Minimum Java Runtime: Java RTE 5.0 (1.5.0.04) 

IBM   AIX 5.2  

Minimum Java Runtime: Java Run-Time 5.0 (1.5.0 20060511) 

Sun/Solaris Solaris 2.8  (SPARC processors only) 

Minimum Java Runtime: Java Run-Time 5.0 (1.5.0_06) 
 
 
Java Run-Time Environment (JRE) for UNIX Systems 

VERICUT is tested with the minimum JRE versions shown above. Later JRE versions 
should work, but for practical reasons not all JRE versions can be tested on all platforms.   

Following are links to each UNIX vendor’s java information and download site for the 
version specified. UNIX system administrators should check these sites for the latest 
operating system patch information, and ensure that the computer used for VERICUT is 
at the minimum patch level for the Java Run-Time version being used. 

HP http://h20392.www2.hp.com/portal/swdepot/displayProductInfo.do?productNumber=
HPUXJDKJRE50 

Sun  http://java.sun.com/javase/downloads/index_jdk5.jsp 
IBM  http://www-128.ibm.com/developerworks/java/jdk/aix/service.html 

 

 

Next installation task:  
If this is a new installation or you do not already have a VERICUT 7.0 license, determine 
your license server computer HOST ID and request a VERICUT license. 

 

Otherwise, continue on:  
Install VERICUT: Windows or UNIX. 

 

Return to Installation Steps. 

 

 

 

http://h20392.www2.hp.com/portal/swdepot/displayProductInfo.do?productNumber=HPUXJDKJRE50
http://h20392.www2.hp.com/portal/swdepot/displayProductInfo.do?productNumber=HPUXJDKJRE50
http://java.sun.com/javase/downloads/index_jdk5.jsp
http://www-128.ibm.com/developerworks/java/jdk/aix/service.html


 

3. Determine Your Host ID and Request a License 
 

License overview 
VERICUT is licensed by a license server program, running on the license server 
computer. Any computer capable of running VERICUT can be used as the license 
server computer. When the license server program starts it reads encrypted license keys 
from a file and compares them with the HOST ID of the computer it is running on. If the 
encrypted keys match the HOST ID, the license keys are added to the license server. 
Once the license server is fully up and available it contains a pool of VERICUT licenses. 
When VERICUT runs it obtains licenses from the license server. 

NOTE:  If this is a new installation or you are changing license server computers you 
must first Determine the HOST ID of the new license server computer, then request 
license keys via CGTech's website (see below). 

Determining the HOST ID of the license server computer 
 
Windows 
 
1. Insert the VERICUT CD into the license server computer's CD-ROM drive. 

2. Cancel from the install screen (if it appears). 

3. Double-click on the 'hostinfo.bat' file located in the CD's top level directory. 

A command prompt window should appear displaying the host name of the computer you 
are on and the address of all enabled Ethernet devices. Your HOST ID is the Ethernet 
address displayed in the window. If more than one address is shown choose the one most 
likely to be always enabled. If no Ethernet address is displayed, enable a network adaptor 
and try again. 

If you do not have access to the VERICUT CD, see Alternate Method to Determine Your 
Windows License Server Computer’s HOST ID. 

 

UNIX 
1. Insert the CD into the license server computer’s CD-ROM drive. 

2. Mount the CD (if your computer does not automatically mount it). 

3. Change directories to the CD-ROM mount directory (e.g. cd /cdrom). 

4. Type ./hostinfo.ux to run the program that determines the HOST ID. 

5. The HOST ID is the “ID Prom” value returned from the command. Valid HOST IDs 
are eight characters containing only 0-9 and A-F. 

If you do not have access to the VERICUT CD, see Alternate Method to Determine Your 
UNIX License Server Computer’s HOST ID. 

 



 

Request a VERICUT license 
Once you have determined your license server computer's HOST ID, go to the License 
Request  page on CGTech's website (this link requires an internet connection).  

 

If you are updating the license on your existing license server computer, and your 
company contact information has not changed, you can use the "License Quick Form" 
link on the license request page. 

 

If you are requesting a license for this computer for the first time, for either a new 
VERICUT installation or to transfer a license from one computer to another, use the 
"License Request Form" link. You can also use this form to change your company or 
contact information. 

 

Copy and paste your HOST ID onto the web form to avoid typing errors. 

 
Special Information for Redundant License Server installations 
CGTech provides a special license for Redundant License Servers. This type of license 
is typically only used by sites with a large number of VERICUT licenses and users, often 
residing in different time zones and locations. Use of redundant license servers increases 
the complexity of the VERICUT installation and requires significant network 
administration and configuration experience to support and maintain. 

A redundant license server configuration requires three (3) HOST ID's from three 
separate networked computers. Determine the HOST ID's on the 3 license server 
computers using the instructions above. 

To request a redundant license, click on the "REDUNDANT LICENSE" link at the top 
of the "License Request Form" web page. The link takes you to the "Redundant 
License Request Form". Enter the 3 HOST ID's on the form. 

More information about setting-up a redundant license server is provided during the 
license server configuration steps in this guide. 

 

Next installation task: Install VERICUT, Windows or UNIX 

 

Return to Installation Steps. 

 
 

http://www.cgtech.com/license/
http://www.cgtech.com/license/


 

4. Install VERICUT on a Stand-alone or License Server 
Computer 
 

Go to one of the following: 

Install VERICUT on a Windows Stand-alone or License Server Computer – See 
below. 

Install VERICUT on a UNIX Stand-alone or License Server Computer 

 

Install VERICUT on a Windows Stand-alone or License 
Server Computer 
Follow the steps below to install VERICUT on the Windows (XP, XP64, 2000) computer 
that will run the license server program.  This is the computer with the network adapter 
HOST ID (Ethernet address) used to create the VERICUT licenses. 

NOTE:  CGTech recommends you install software as "Administrator," but it is not 
required. 

Some hints on where to install VERICUT 
• Your type of VERICUT installation (Stand-alone, Multiple Computer, or Multiple 

Computer Network ) determines where you should install VERICUT. In both 
Stand-alone and Multiple Computer types of installations VERICUT is installed 
on the local disk of each computer that will run VERICUT. In the Multiple 
Computer Network installation VERICUT is installed once on a network-
accessible disk. 

• For any Multiple Computer or Network installation, make sure that the computer 
you choose as the license server computer can be communicated with by all the 
VERICUT client computers, and vice-versa. 

• It is possible to install the license server only, for those configurations where it is 
not desirable to install VERICUT on the license server computer. See Install 
VERICUT License Server Only 

• For security purposes we strongly advise against running the license server on the 
same computer that acts as an internet firewall for a local network. 

Updating an existing VERICUT installation 
If you are updating an existing VERICUT installation, DO NOT install a new version of 
VERICUT in the same folder as the existing installation. Always choose a new or empty 
folder for a VERICUT installation.  

DO NOT remove the existing VERICUT software from the license server computer 
without first Stopping and Removing the Windows License Server. Carefully read and 



 

follow the information in the "Next installation task" (link at the bottom of this page) 
regarding configuring and starting the license server. 

 

Windows XP 64 Installation Tips 
• It is not necessary to install the standard (32 bit) Windows version of VERICUT. 

• You must install the Windows redistributable C++ runtime libraries. See System 
Requirements for more information and how to get the installer files. 

 

VERICUT Installation 
1. Insert the CD and run the Windows installation program. 

If your computer does not automatically start the installation program, double-click 
on or run the "install.exe" program from the CD. 

2. Follow the installation "Wizard". 

VERICUT uses a typical "Wizard" type installation where you step through a series 
of screens to configure your installation. The last choice, prior to the "Finish" screen, 
begins the installation. 

Overview of the installation steps: 

Choose the installation language. 
Accept the License Agreement. 
Specify the folder path where VERICUT will be installed. 
Choose the type of installation. (Full is recommended) 
Select the VERICUT platforms to install. Choose Windows (32 bit) or Windows 64 bit, 
depending on your operating system. 
Select desktop icons and start menu buttons to add to the installing user's profile. Choose 
VERICUT, and/or Mold and Die, and/or Cutter Grinder. 
Enter the license server host name. (assumes the installing computer's host name, but can 
be changed) 
Select default units. 
Install VERICUT. 
 
Special Information for Redundant License Server configurations 
A redundant license server configuration uses three (3) license server computers. One of 
the license server computers is designated the "leader", the other two are "followers". The 
redundant license servers are configured in the next step. However, during installation 
you must enter the license server host name. If you are using redundant license servers 
you must enter all three host names in the installation screen's text field, in the following 
format: 

hostname1:hostname2:hostname3 
Where "hostname1" is the actual host name of the leader (or main) redundant server, and 
"hostname2" and "hostname3" are the names of the follower servers. 



 

 

Next installation task: Configure and Start the Windows License Server 

 

Return to Installation Steps. 

 



 

 

Install VERICUT on a UNIX Stand-alone or License 
Server Computer 
 

Follow the steps below to install VERICUT on the computer that will run the license 
server program.  This is the computer identified by the HOST ID that the license is 
locked to. 

CGTech recommends that you install software as the 'root' user, but it is not required.  Do 
not 'set user' (su) to root as this does not always correctly execute the root account's login 
process. 

 

Some hints on where to install VERICUT 
• Your type of VERICUT installation (Stand-alone, Multiple Computer, or Multiple 

Computer Network ) determines where you should install VERICUT. In both 
Stand-alone and Multiple Computer types of installations VERICUT is installed 
on the local disk of each computer that will run VERICUT. In the Multiple 
Computer Network installation VERICUT is installed once on a network-
accessible disk. 

• For any Multiple Computer or Network installation, make sure that the computer 
you choose as the license server computer can be communicated with by all the 
VERICUT client computers, and vice-versa. 

• It is possible to install the license server only, for those configurations where it is 
not desirable to install VERICUT on the license server computer. See Install 
VERICUT License Server Only 

• For security purposes we strongly advise against running the license server on the 
same computer that acts as an internet firewall for a local network. 

Updating an existing VERICUT installation 
If you are updating an existing VERICUT installation, DO NOT install a new version of 
VERICUT in the same folder as the existing installation. Always choose a new or empty 
folder for a VERICUT installation.  

DO NOT remove the existing VERICUT software from the license server computer 
without first Stopping and Removing the UNIX License Server. Carefully read and 
follow the information in the "Next installation task" (link at the bottom of this page) 
regarding configuring and starting the license server. 

 



 

 

VERICUT Installation 
1. Insert the CD, change to the CD-ROM directory, and run the installation 

program. 
Most UNIX systems automatically mount the CD when it is inserted. If yours does not, or 
if it mounts the CD without read and execute permissions, dismount and remount the CD. 
See the section on how to Mount a UNIX CD for how to mount the CD manually. 
Change directories to the CD-ROM mount directory (e.g. cd /cdrom), then type: 

"./INSTALL.UX" (without the quotes). 

If this command fails, try: "./install.ux" or "./INSTALL.UX\;1". 

2. Follow the on-screen instructions. 
VERICUT uses a typical "Wizard" type installation where you step through a series of 
screens to configure your installation. The last choice, prior to the "Finish" screen, begins 
the installation. 

Overview of the installation steps: 

Choose the installation language 

Accept the License Agreement 

Specify the directory path where VERICUT will be installed 

Choose the type of installation (Full is recommended) 

Select the VERICUT platforms to install. Choose HP, and/or RS, and/or Solaris 

Enter the license server host name (assumes the installing computer's host name, but 
can be changed) 

Select default units 

Install VERICUT 

Special Information for Redundant License Server configurations 
A redundant license server configuration uses three (3) license server computers. One of 
the license server computers is designated the "leader", the other two are "followers". The 
redundant license servers will be configured in the next step. However, during installation 
you must enter the license server host name. If you are using redundant license servers 
you must enter all three host names in the installation screen's text field, in the following 
format: 

hostname1:hostname2:hostname3 

Where "hostname1" is the actual host name of the leader redundant server, and 
"hostname2" and "hostname3" are the names of the follower servers. 

3. Add VERICUT commands to the user's execution path.  
Add the files located in the "platform/commands" directory of your VERICUT 
installation to the user's execution path. Typically this is done using your UNIX 



 

platform's system administration utility. However this can also be configured manually 
by either adding the 'commands' directory to the PATH environment variable for each 
user's login process, or by copying the files to a directory that is already in each user's 
execution path. 

 

 

NOTES:  
1. Once VERICUT’s "commands" files are added to the user's execution path, the 

user must log-out and log-in to recognize the commands. 
2. VERICUT can also be executed directly by typing the path and 'vericut' script file 

name in a UNIX command or terminal shell. For example, if your software is 
installed in /usr/cgtech60 on a Sun/SOLARIS platform, the command to run 
VERICUT directly is: 

/usr/cgtech60/solaris/commands/vericut 
 

Next installation task: Configure and Start the UNIX License Server  

 

Return to Installation Steps. 



 

 

5. Configure and Start the License Server 
 

Choose one of the following: 

Create the License File and Start the License Server on a Windows Computer – 
See below. 

Create the License File and Start the License Server on a UNIX Computer 

 

Create the License File and Start the License Server on 
a Windows Computer 
 

The license server computer runs the license server program. This program must be 
running on a computer that is network-accessible by VERICUT client computers. Valid 
VERICUT licenses must be available on the license server in order for VERICUT to 
operate. 

VERICUT licensing is specific to each major version of VERICUT (5.4, 6.0, 6.1, etc.). 
Licensing from earlier major versions will not allow newer versions to run. Point 
releases, such as 6.1.1, are licensed by the major version. For example, VERICUT 6.1.1 
only works with a 6.1 (or higher) license. 

The following steps assume that you have a license email from CGTech for this major 
VERICUT version, and you are ready to configure the license server and apply your 
license. If you have not requested a license from CGTech, go back to the Introduction for 
information about how to request a license. 

The license email contains instructions on how to create a license file. Those instructions 
are repeated here as well. Follow the instructions carefully and DO NOT ALTER ANY of 
the content of the license email. Doing so may invalidate the license file and result in 
errors when running VERICUT. 

VERICUT uses the Sentinel RMS license server program from SafeNet . The Sentinel 
RMS license server is a full featured software licensing tool used by several software 
companies to license their application programs. Sentinel RMS contains optional features 
not mentioned in this brief discussion of basic license server configuration. For more 
information about advanced license server configuration options, see the Sentinel RMS 
License Manager System Administrator's Guide. 

http://www.safenet-inc.com/
http://cgtech.com/support/sentinel/administration
http://cgtech.com/support/sentinel/administration


 

 

Update installation (when a previous version of VERICUT is installed 
on the license server computer) 
If you plan to run multiple VERICUT versions from one license server, configure and use 
the license server from the latest (newest) version. Be sure to stop the current license 
server and remove its service, if applicable. See Stop and Remove a CGTech License 
Server 

If you are running VERICUT 5.2 or 5.3 from this license server, see the section, Running 
VERICUT 5.2 or 5.3 with a newer VERICUT License. 

 

Redundant license servers 
If you are using a special redundant license server configuration, go to the Windows 
Redundant License Server Setup section. DO NOT CONTINUE with the rest of this page 
if you are configuring redundant license servers. 

 

Configure the license server to automatically start as a Windows service 
(recommended) 
NOTE:   The following steps must be done by an Administrator user. 

 

1. Select Start > All Programs > CGTech VERICUT 7.0 > License Server Only > 
Configure License & Setup Server.  

2. In the command prompt window read the informational messages then press any key 
to continue. 

3. When the Create VERICUT License File screen displays, drag and drop the 
VERICUT license email from Microsoft Outlook, or Outlook Express, into the Create 
VERICUT License File screen. If you use another email program or cannot access the 
license email from the license server computer, save the license email as a "Text 
Only" or plain text file, then drag and drop the saved file into the Create VERICUT 
License File screen. You can also Copy/Paste the email contents into the Create 
VERICUT License File screen. 

4. Close the Create VERICUT License File screen after the license file has been created. 

5. Continue reading messages displayed in the command prompt screen, press any key 
to continue. 

6. When the command prompt window closes, the license server should be configured 
for use and you can proceed to the next step. 



 

 
Verify that the license server started 
The license server program should now be running on your computer and should be 
configured to automatically start. You can confirm that the server program is running 
using the Sentinel License Administrator program. Select Start > All Programs > 
CGTech VERICUT 7.0 > License Administration > SentinelLM License 
Administrator (Wlmadmin). You should see your license server computer's host name 
appear under the Defined Servers list under the "tree" displayed on the left side of the 
window. Expand the name to see the VERICUT licenses available. 

The VERICUT license server computer is now configured to automatically start the 
license server program, the VERICUT license keys exist in ...\windows\license\cgtech.lf, 
and the license server program is configured to read VERICUT license keys from the file 
when it starts. 

You should now be able to run VERICUT on the license server computer using licenses 
provided by the license server. 

NOTE:  If for some reason you cannot configure the license server service to start 
automatically as described above, and then see Starting a Temporary License Server. 

 

If errors occur, visit the VERICUT Users' Forum  or contact CGTech technical support 
via our website, just click on the support link. 

Next installation task: Test VERICUT on the Windows License Server 

 

Return to Installation Steps. 
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Create the License File and Start the License Server on 
a UNIX Computer 
 

The license server computer runs the license server program. This program must be 
running on a computer that is network-accessible by VERICUT client computers. Valid 
VERICUT licenses must be available on the license server in order for VERICUT to 
operate. 

VERICUT licensing is specific to each major version of VERICUT (5.4, 6.0, 6.1, etc.). 
Licensing from earlier major versions will not allow newer versions to run. Point 
releases, such as 6.1.1, are licensed by the major version. For example, VERICUT 6.1.1 
only works with a 6.1 (or higher) license. 

The following steps assume that you have a license email from CGTech for this major 
VERICUT version, and you are ready to configure the license server and apply your 
license. If you have not requested a license from CGTech, go back to the Introduction for 
information about how to request a license. 

The license email contains instructions on how to create a license file. Those instructions 
are repeated here as well. Follow the instructions carefully and DO NOT ALTER ANY of 
the content of the license email. Doing so may invalidate the license file and result in 
errors when running VERICUT. 

VERICUT uses the Sentinel RMS license server program from SafeNet. The Sentinel 
RMS license server is a full-featured software licensing tool used by several software 
companies to license their application programs. Sentinel RMS contains optional features 
not mentioned in this brief discussion of a basic license server configuration. For more 
information about advanced license server configuration options see the Sentinel RMS 
License Manager System Administrator's Guide. 

 
Update installation (when a previous version of VERICUT is installed 
on the license server computer) 
If you plan to run multiple VERICUT versions from one license server, configure and use 
the license server from the latest (newest) version. Be sure to stop the current license 
server and remove its service, if applicable. See Stop and Remove a CGTech License 
Server 

If you are running VERICUT 5.2 or 5.3 from this license server, see the section, Running 
VERICUT 5.2 or 5.3 with a newer VERICUT License. 

 
Redundant license server configuration 
If you are using a special redundant license server configuration, go to the UNIX 
Redundant License Server Setup section. DO NOT CONTINUE with the rest of the steps 
on this page. 

http://www.safenet-inc.com/
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License server configuration, startup and licensing 
NOTE:  The following must be done logged-in as the computer's 'root' user. Do not 'set 
user' (su) to root as this does not always correctly execute the root account's login 
process. 

1. Configure and start the License Server. 
CGTech recommends you configure the license server program to automatically start 
when you start your license server computer. The method for doing this depends on 
your particular UNIX platform and how your system's administrator prefers to 
manage the computer's startup process. Most UNIX systems use their own graphical 
system management utility program, such as SAM for HPUX or SMIT for IBM 
RS6000/AIX, to configure the computer's startup processes. 

NOTE FOR UPDATE INSTALLATIONS:  Before beginning the license 
server configuration, be sure to stop the existing VERICUT license server running on 
the license server computer. If you have automated the license server startup, remove 
it from your system's startup configuration using your systems' management utility 
program. Only one Sentinel RMS license server program may run on a computer. 

The VERICUT installation includes a UNIX script that launches the license server 
program. The script file name is "start_server" and is located in the 'platform/license' 
directory of your VERICUT installation, where platform is: hp, solaris, or rs. Add this 
script to the license server computer's startup processes using your platform's system 
management utility. If your platform's system management utility gives you a choice, 
add the license server startup after the network services startup. 

Reboot the computer after adding the license server program to your system's startup 
process to verify that it starts correctly upon reboot. If it is not possible to reboot your 
license server computer now, start the license server program manually using your 
platform's system management utility. 

If it is not possible to start the license server using your system's utilities, in order to 
complete the licensing process, the 'root' user can manually start the license server 
program by executing the start_server script from a command or terminal shell. 
However, the server process will be owned by the 'root' user and will terminate when 
the 'root' user logs-out. Manually starting the license server program in this way is not 
recommended as a permanent configuration. 

Ignore the following warnings if they appear, we will add the license file in the next 
steps: 

Warning: Could not open file "/usr/cgtech70/solaris/license/cgtech.lf" 

No applications licensed. 

 
2. Verify the license server started. 

The license server program should now be running on your computer and should be 
configured to automatically start. A utility is provided to detect the license server 



 

program. The program is called 'lswhere' and is located in the 'platform/license' 
directory of your VERICUT installation. Execute the lswhere program from a 
command or terminal shell to determine if the license server program is running. For 
example, if your license server computer is a Sun computer running the SOLARIS 
operating system, and VERICUT is installed in the /usr/cgtech60 directory, then type 
the following command: 

/usr/cgtech60/solaris/license/lswhere 
 

If the license server is running you should see the following information displayed by 
the lswhere utility: 

Sentinel RMS 8.0.5 Search Tool For License Servers 

Copyright (C) 2006 SafeNet, Inc. 

  

Server Address     : 199.1.1.123 

Server Name        : mycomputer 

(in this example the server computer's host name is 'mycomputer' and its IP 
address is 199.1.1.123) 

 
3. Copy the license keys from the CGTech license email to a text file. 
 

Open the license email you received from CGTech. 
Copy the license keys from the license email. DO NOT copy the entire email 
text. Start with the line that begins '# Company: ', and select all lines down to and 
including the line '# End of license '. 
Paste the lines into a plain text editor such as vi. Do not use a word processing-type 
editor like Microsoft Word. 
Save the text as a plain text file. Name the file and save it in a directory so that you 
can easily find it later. For example, save the file as 'vericut60_license_keys.txt' in 
your default login directory. This file is not used once the license keys are added to 
the license server in the next step. CGTech recommends you keep the file for archive 
purposes. 

NOTE:  When pasting into the plain text editor make sure that the long license 
key lines are not automatically truncated or split into separate lines. 

 
4. Add the license keys to the license server and license file using lslic. 

Add the license keys to the running license server and save them in the license file. In 
a UNIX command or terminal shell execute the 'lslic' utility program from the 
'platform/license' directory in your VERICUT installation. Continuing with our 
example from above, the command would look like: 



 

/usr/cgtech60/solaris/license/lslic –F 
/users/mylogin/vericut60_license_keys.txt 

Where /usr/cgtech60 is the VERICUT installation folder on a Sun SOLARIS 
platform. The license keys are loaded from the file saved in step 3D above. The –F 
option adds the keys to the license server from the specified file, and saves them in 
'cgtech.lf' located in the 'platform/license' directory in your VERICUT installation. 

 
5. Verify the license keys were successfully added to the server. 

In a UNIX command or terminal shell execute the 'lsmon' utility program from the 
'platform/license' directory in your VERICUT installation. Continuing with our 
example from above, the command would look like: 

/usr/cgtech60/solaris/license/lsmon mycomputer 
Where 'mycomputer' is the host name of the license server computer. If the 
license keys were correctly applied you should see something like the following 
information displayed by the lsmon utility: 

 

        Sentinel RMS 8.0.5 Application Monitor 

        Copyright (C) 2006 SafeNet, Inc. 

  

[Contacting Sentinel RMS server on host "mycomputer"] 

  

License type   : "Normal License." 

Commuter License Allowed : NO 

Feature name   : "VERICUT.SUN" 

Feature version   : "7.0" 

Max concurrent user(s)  : Unlimited. 

Unreserved Tokens in use : 0 

Available unreserved         : Unlimited. 

Reserved Tokens in use       : 0 

Available reserved           : 0 

Soft limit on users          : Unlimited. 

  

License start date           : Mon Mar 15 00:00:00 2004 

Expiration date              :  License has no expiration. 

Application-server locking   : Server-locked license. 



 

Additive/exclusive           : Exclusive license (overrides additive licenses). 

Held licenses                 : Allowed, hold time set by application. 

Token lifetime (heartbeat)   : 300 secs (5 min(s)) 

. 

. 

. 
(each license key should be displayed) 

 

The VERICUT license server computer is now configured to automatically start the 
license server program, the VERICUT license keys exist in …/platform/license/cgtech.lf, 
and the license server program is configured to read VERICUT license keys from the file. 

 

You should now be able to run VERICUT on the license server computer using licenses 
provided by the license server. 

 

If errors occur, visit the VERICUT Users'Forum  or contact CGTech technical support 
via our website, just click on the support link. 

 
Next installation task: Test VERICUT on a UNIX license server computer 

 

Return to Installation Steps. 
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6. Test VERICUT for Correct Operation and Licensing 
on the License Server Computer 
 

Choose one of the following: 

Test VERICUT Windows Installation on the License Server Computer – See 
below. 

Test VERICUT UNIX Installation on the License Server Computer 

 

Test VERICUT Windows Installation on the License 
Server Computer 
 

Run VERICUT using the icon added to your desktop, or by clicking Taskbar: Start > 
Programs > CGTech VERICUT x.x > VERICUT x.x (where "x.x" is the installed 
version).  

After the VERICUT window opens, press the green "Play to End" button  (located in 
the lower right corner of the VERICUT window). A short simulation will run.  

If you do not have a "Machine Simulation" license, a notice displays. After pressing OK 
in the notice dialogue, the workpiece will be cut but the machine will not move- this is 
normal, since no Machine Simulation license is available.  

You can check that you are running the expected VERICUT version by selecting Help > 
About VERICUT. Available licenses are displayed by selecting Help > License ….  

When finished, select File > Exit (located in the menu bar in the upper left corner of the 
VERICUT window) to close the VERICUT window. 

 

Congratulations! 
 

 
You are finished installing VERICUT on your license server computer. 

 
Continue on to the next step if you have other computers that will run VERICUT and get 
their licenses from the license server computer you just finished installing. 
 

If errors occur, visit the VERICUT Users’ Forum  or contact CGTech technical support 
via our website, just click on the support link. 
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Next installation task: Configure and Test VERICUT on client computers 

 

Return to Installation Steps. 



 

 

Test VERICUT UNIX Installation on the License 
Server Computer 
 

Run VERICUT by typing the command 'vericut' in a command or terminal shell. If the 
VERICUT command scripts are not in your execution path, you can run the 'vericut' 
execution script directly. It is located in the 'platform/commands' directory of your 
VERICUT installation, where platform is: hp, rs, or solaris. For example, if VERICUT is 
installed on a Sun/SOLARIS computer in the /usr/cgtech60 directory, the command to 
run VERICUT is: 

/usr/cgtech60/solaris/commands/vericut 
 

After the VERICUT window opens, press the green "Play to End" button,  (located in 
the lower right corner of the VERICUT window). A short simulation will run.  

If you do not have a "Machine Simulation" license, a notice displays. After pressing OK 
in the notice dialogue, the workpiece will be cut but the machine will not move- this is 
normal, since no Machine Simulation license is available. 

You can check that you are running the expected VERICUT version by selecting Help > 
About VERICUT. Available licenses are displayed by selecting Help > License ….  

When finished, select File > Exit (located in the menu bar in the upper left corner of the 
VERICUT window) to close the VERICUT window. 

 

Congratulations! 
 

You are finished installing VERICUT on your license server computer. 
 
Continue on to the next step if you have other computers that will run VERICUT and get 
their licenses from the license server computer you just finished installing. 
 

If errors occur, visit the VERICUT Users’ Forum  or contact CGTech technical support 
via our website, just click on the support link. 

 

Next installation task: Configure and test VERICUT client computers 

 

Return to Installation Steps. 
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7. Configure and Test VERICUT Client Computers 
 

Choose one of the following: 

Configure and Test Windows Client Computers – See below. 

Configure and Test UNIX Client Computers 

 

Configure and Test Windows Client Computers 
 

Once VERICUT is installed on the license server computer, and the license server is 
running, you can setup VERICUT on each Windows client computer. In order to receive 
licenses from the license server computer the client and license server computers must 
communicate with each other over the network. Verification of client/server 
communication was covered in previous instructions. See the section, Check Windows 
Network Configuration for more information. 

Follow the steps below to configure client computers to run VERICUT and receive 
licenses from the license server. Steps differ depending on the type of network 
configuration: 

Multiple Computer installation — VERICUT is installed on the local disk of each 
computer (client and license server) that will run VERICUT. 

Multiple Computer Network installation — VERICUT is installed on a network 
mapped disk. VERICUT is not locally installed on the client computer. The client 
computer accesses VERICUT from the mapped disk. 

NOTE:  Do not create a license file or start the license server program on the client 
computer. The license server computer was configured in previous installation 
instructions. 

 
To configure client computers in a Multiple Computer installation: 
Install VERICUT on a local disk on each client computer. While stepping through the 
installation wizard you will see a screen containing the name of the license server 
computer. By default the license server computer name is set to the host name of the 
installing computer (in this case a client computer that does not run the license server 
program). 

Change the License Server host name to the name of the VERICUT license server 
computer (where you installed VERICUT and setup the license server previously). 

 



 

To configure client computers in a Multiple Computer Network 
installation: 
NOTE:  From previous steps, VERICUT should currently be installed on a network-
accessible disk. This was done during installation and configuration of the license server 
computer.  

1. Map the disk containing VERICUT to each client computer using the same drive 
letter and folder path as the license server computer. 

2. Copy the file "Shortcut to VERICUT x.x" from the "windows\commands" directory 
of your VERICUT installation to the desktop of each client computer. Rename the 
shortcut as desired. 

3. Optionally, copy the entire CGTech VERICUT x.x Start Menu folder from the license 
server computer Start Menu to each client computer’s Start Menu. 

 
Test your Windows client installation: 
 
1. Run VERICUT using the icon added to the client computers desktop (or other 

desktop or Start Menu shortcut you created).  
2. After the VERICUT window opens, press the green "Play to End" button  (located 

in the lower right corner of the VERICUT window). A short simulation will run.  
3. If your licensing does not include the "Machine Simulation" option, a notice displays. 

After pressing OK in the notice dialogue, the workpiece will be cut but the machine 
will not move- this is normal, since no Machine Simulation license is available.  

4. You can also check that you are running the correct VERICUT version and the proper 
licenses are available by selecting Help > About VERICUT.  

5. When finished, select File > Exit (located in the menu bar in the upper left corner of 
the VERICUT window) to close the VERICUT window. 

 

If errors occur, visit the VERICUT Users’ Forum  or contact CGTech technical support 
via our website, just click on the support link. 

 

Your VERICUT Windows installation is now complete. 

 

If you need to install one of the CAM Interface modules, go to one of the following:  

Installing the CATIA-to-VERICUT Interface (CATV) for CATIA version 4 

Installing the CATIA V5-to-VERICUT Interface for CATIA version 5 

Installing the EdgeCAM-to-VERICUT Interface 

Installing the GibbsCam-to-VERICUT Interface (GibbsV) 

Installing the Mastercam-to-VERICUT Interface (MCAMV)  

Installing the NX-to-VERICUT Interface (NXV) 
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If you need to install the CAD Model Interface modules, go to Installing the Model 
Interface Modules.  
 
 
If you need to install the VERICUT TDM Interface, go to Installing the VERICUT TDM 
Systems Interface. 

 

Return to Installation Steps. 

 



 

 

Configure and Test UNIX Client Computers 
 

Once VERICUT is installed on the license server computer, and the license server is 
running, you can setup VERICUT on each UNIX client computer. In order to receive 
licenses from the license server computer the client and license server computers must 
communicate with each other over the network. Verification of client/server 
communication was covered in previous instructions. See the section, Check UNIX 
Network Configuration for more information. 

Follow the steps below to configure client computers to run VERICUT and receive 
licenses from the license server. Steps vary depending on the type of network 
configuration: 

Multiple Computer installation — VERICUT is installed on the local disk of each 
computer (client and license server) that will run VERICUT. 

Multiple Computer Network installation — VERICUT is installed on a network 
mounted disk. VERICUT is not locally installed on the client computer. The client 
computer accesses VERICUT from the network mounted disk. 

NOTE:  Do not create a license file or start the license server program on the client 
computer. The license server computer was configured in previous installation 
instructions. 

 
To configure client computers in a Multiple Computer installation: 
1. Install VERICUT on a local disk on each client computer. While stepping through the 

installation wizard you will see a screen containing the name of the license server 
computer.  By default the license server computer name is set to the host name of the 
installing computer (in this case a client computer that does not run the license server 
program). Change the License Server host name to the name of the license server 
computer for your VERICUT installation (as configured in previous installation 
tasks). 

2. Add the files located in the "platform\commands" directory of your VERICUT 
installation to the execution path of each client computer. Typically this is done using 
your UNIX platform's system administration utility. However this can also be 
configured manually by either adding the 'commands' directory to the PATH 
environment variable for each user's login process, or by copying the files to a 
directory that is already in each user's execution path. 

NOTE:  Once VERICUT's "commands" files are added to the user's execution 
path, the user must log-out and log-in to recognize the commands. 

 



 

To configure client computers in a Multiple Computer Network 
installation: 
NOTE:  From previous installation tasks, VERICUT should currently be installed on a 
network-accessible disk. This was done during installation and configuration of the 
license server computer.  

1. Mount the disk containing VERICUT to each client computer using the exact same 
path as the license server computer. Be sure to add the mount path to your client 
computer's startup using your platform's system administration utility. 

2. Add the files located in the "platform\commands" directory of your VERICUT 
installation to the execution path of each client computer. Typically this is done using 
your UNIX platform's system administration utility. However this can also be 
configured manually by either adding the 'commands' directory to the PATH 
environment variable for each user's login process, or by copying the files to a 
directory that is already in each user's execution path. 

NOTE:  Once VERICUT's 'commands' files are added to the user's execution path, 
the user must log-out and log-in to recognize the commands. 

 

Test your UNIX client installation: 
 
1. Run VERICUT by typing the command 'vericut' in a command or terminal shell. 

2. After the VERICUT window opens, press the green "Play to End" button,     
(located in the lower right corner of the VERICUT window). A short simulation will 
run.  

3. If your licensing does not include the "Machine Simulation" option, a notice displays. 
After pressing OK in the notice dialogue, the workpiece will be cut but the machine 
will not move- this is normal, since no Machine Simulation license is available. 

4. You can also check that you are running the correct VERICUT version and the proper 
licenses are available by selecting Help > About VERICUT.  

5. When finished, select File > Exit (located in the menu bar in the upper left corner of 
the VERICUT window) to close the VERICUT window. 

 

If errors occur, visit the VERICUT Users’ Forum  or contact CGTech technical support 
via our website, just click on the support link. 

 

Your VERICUT UNIX installation is now complete. 
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If you need to install one of the CAM Interface modules, go to one of the following:  

Installing the CATIA-to-VERICUT Interface (CATV) for CATIA version 4 

Installing the CATIA V5-to-VERICUT Interface for CATIA version 5 

Installing the EdgeCAM-to-VERICUT Interface 

Installing the GibbsCam-to-VERICUT Interface (GibbsV) 

Installing the Mastercam-to-VERICUT Interface (MCAMV)  

Installing the NX-to-VERICUT Interface (NXV) 
 
 
If you need to install the CAD Model Interface modules, go to Installing the Model 
Interface Modules.  
 
 
If you need to install the VERICUT TDM Interface, go to Installing the VERICUT TDM 
Systems Interface. 

 

Return to Installation Steps. 

 

 



 

 

Other VERICUT Configuration Tasks 

Windows Start Menu License Administration Choices 
 

The following describe the different Windows "Start Menu" choices under Start > All 
Programs > CGTech VERICUT 7.0 > License Administration. Some of these choices 
only display information and some require a Windows administrative user in order to 
make changes to system settings. 

  

License Utilities 
"License Utilities" choices are intended to help setup licensing or diagnose license 
problems on either the license server computer or the VERICUT client computer. 

  

Display Local License Servers 
View all Sentinel RMS license servers on this subnet. This choice uses the Sentinel 
RMS lswhere utility to display all Sentinel RMS license servers that can be 
communicated with. It uses Sentinel RMS's 'broadcast' feature to contact and collect 
information about various Sentinel RMS license servers on the same subnet as the 
current computer. It reports on any Sentinel RMS license servers, which may or may 
not have VERICUT licenses. For more information about advanced license server 
configuration options, see the Sentinel RMS License Manager System 
Administrator's Guide. 

  

Display Network Information 
Check IP and Ethernet addresses of network devices on this computer. This choice 
uses the Windows' command IPCONFIG /ALL to display important network 
information, especially TCP/IP configuration information. This can be used to 
determine if the TCP/IP configuration is valid (i.e. displays a valid IP address of the 
current computer). It also shows if multiple network devices are present, and their 
status. 

  

Sentinel RMS License Administrator (WlmAdmin) 
View licenses and status of running Sentinel RMS license servers using the Sentinel 
RMS Windows’ license utility WlmAdmin. WlmAdmin is configured with the 
VERICUT license server identified during installation as a "Defined Server" in 
WlmAdmin's defined server list. For more information about the WlmAdmin utility 
see the Sentinel RMS License Manager System Administrator's Guide. 

http://cgtech.com/support/sentinel/administration
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Specify License Server Computer 
(requires privileges to write to the VERICUT installation folders) 

Direct VERICUT to get its licenses from a different license server computer. The 
choice opens the VERICUT configuration file, cgtenv.bat in Windows' Notepad text 
editor. Comments in the file identify the LSHOST environment variable and how to 
change it to specify a different VERICUT license server computer's host name. For 
more information about the LSHOST environment variable see the Sentinel RMS 
License Manager System Administrator's Guide. 

  

License Server Only 
"License Server Only" choices are only intended to be used on the license server 
computer, to help setup licensing or diagnose license problems. 

Configure License & Setup Server 
(requires administrative privileges) 

This is typically the only selection used when setting-up a Windows license server. It 
does the following: 

1. Opens the Create License program and instructs the administrator to 
drag/drop the VERICUT license email into the screen. This creates the 
'cgtech.lf' license file in the license folder. 

2. Sets the system environment variable LSERVOPTS to point to the license 
file just created. 

3. Removes any previous Sentinel RMS license server service, then adds and 
starts the license server service from the current installation folder. When the 
server starts (via the service) it looks for the license file defined in 
LSERVOPTS, and adds the license keys. 

 

Display Host ID 

Display the Ethernet address of all enabled network adapters on this computer. The 
user selects one of these displayed Ethernet addresses as the HOST ID used to lock 
the license server to this computer. The program that displays the Ethernet addresses 
uses the exact same logic as the license server program. When a license is added to 
the license server program, it is compared against enabled network adapters. If the 
network adaptor encrypted in the license key does not match any of the enabled 
network adaptors, the key is not added to the license server. 

http://cgtech.com/support/sentinel/administration
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Remove License Server Service 
(requires administrative privileges) 

Stops the license server and removes the license server service on this computer. You 
can use Start License Server Service to restart a license server that is installed as a 
service. 

  

Run Temporary License Server 
Starts a temporary license server from the current user's login. You may use this 
choice to temporarily start the license server program, such as for testing or if it is not 
possible to add a service. The license server is temporary because it is terminated 
when the user logs-out of the current session. Use Configure License & Setup 
Server for a permanent installation of the server via Windows Services. 

  

Save License File from License Email 
(requires privileges to write to the VERICUT installation folders) 

Creates the VERICUT license file from a license email or text file containing license 
keys. This choice opens a utility program that reads the license keys in the CGTech 
license email and creates the cgtech.lf license file in the local installation's 'license' 
folder. The utility program reads the license email via: 

1. Drag/drop the email directly from Microsoft Outlook or Outlook Express. 

2. Drag/drop a saved email message file (.msg or .eml). 

3. Copy/paste the email's text. For example you can select all the text (typically 
Edit > Select All in your email program), then paste it into the Create License 
panel with the right-mouse menu > Paste menu button. 

4. Drag/drop a plain text file saved from the license email. 

   

The Create License panel's text area displays all the added license keys, followed by 
the message "License file C:\cgtech70\windows\license\cgtech.lf created 
successfully". The license server program reads the cgtech.lf license file when it 
starts, and adds valid license keys to the running license server. 

  

Set License File Environment Variable 
(requires administrative privileges) 

Sets the LSERVOPTS system environment variable, used by the license server to 
find the cgtech.lf license file when the Windows service starts the license server. This 
setting is only used by the license server started as a Windows service. For more 



 

information about LSERVOPTS and its options see the Sentinel RMS License 
Manager System Administrator's Guide. 

 NOTE:  A restart is required after the environment variable is changed. 

Start License Server Service 
(requires administrative privileges) 

Stops and removes any existing license server service, then installs and starts the 
license server service from the current installation. This choice is only effective when 
using a license server service. 

  

Stop License Server Service 
(requires administrative privileges) 

Stops a running license server service on this computer. The service is not removed, 
only stopped. 

  

 Update Licenses on Running Server  
(requires administrative privileges if used on a license server service) 

Causes the running license server to re-read the license file. The server must be 
running when this selection is used. This selection uses the Sentinel RMS lslic 
program to remove the current licenses, then re-reads the license keys in the cgtech.lf 
license file and adds them to the running license server. For more information about 
the lslic program see the Sentinel RMS License Manager System Administrator's 
Guide. 

 

 

http://cgtech.com/support/sentinel/administration
http://cgtech.com/support/sentinel/administration
http://cgtech.com/support/sentinel/administration
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Alternate Method to Determine Your Windows License 
Server Computer’s HOST ID 
 

If you do not have access to the VERICUT CD you can display the HOST ID as follows: 

• Open a Command Prompt window (also called a DOS window) 

• Type in the window: Ipconfig  /all 

The value shown to the right of "Physical Address" is typically the HOST ID. Valid IDs 
are 12 characters and contain only the characters 0-9 and A-F. If your computer has 
multiple network adapters, the license server program compares the address encrypted in 
the license keys with enabled network adapters. If a network adapter address matching 
the encrypted key address is found then the license is added to the server. 

The following Physical Addresses are not valid, and indicate something is wrong with the 
TCP/IP network protocol configuration for the Ethernet device, or indicates the card is 
not enabled or available: 

000000000000 
204c4f4f5020 
ffffffff 
ffffffffffff 

NOTE:  The license server delivered with this version of VERICUT only requires 
the device to be enabled. It no longer requires it to be connected or have an active 
network transport such as IPX/SPX.  

 

See the section on Check Windows Network Configuration if you are having trouble 
getting a valid Physical Address. 

 

Return to Installation Steps. 

 



 

 

Alternate Method to Determine Your UNIX License 
Server Computer’s HOST ID 
 

If you do not have access to the VERICUT CD, one of the following commands will 
display the HOST ID on each of the different UNIX platforms. 

HP: /usr/bin/uname -i           convert the decimal number that is returned to a hex 
number 

RS: /usr/sbin/hostid             returns a nine or ten character number, remove the first 
2 characters 

 (a zero is added to the front of a 9 character Prom ID for the license file) 

Solaris:  /usr/ucb/hostid      use the number as displayed 

  

Return to Installation Steps. 

 



 

 

Check Windows Network Configuration 
 

In any VERICUT installation there is a computer that functions as the license server 
computer. There are also one or more client computers that run VERICUT and 
communicate with the license server computer to get licenses. In a stand-alone 
configuration the license server computer and the VERICUT client computer are one-in-
the-same, but the same network communication requirements apply. The following 
checks ensure that the license server computer and the VERICUT client computer(s) can 
communicate, and that the VERICUT client computers can successfully run VERICUT. 

 
Checks for both the License Server Computer and VERICUT Client 
Computers 
 
1. Check the network hardware. 

Ensure that you have a network adapter installed and enabled on the license server 
computer. You can use the Windows Device Manager (available under the Control 
Panel's System icon) to see if you have an installed network adapter. The VERICUT 
license keys are encrypted to match the physical address of an enabled network 
adapter. When the license server program initially starts it finds enabled network 
adapters and compares each license key with the physical address of the adapter(s). If 
a match is found the license key is added to the license server. 

 
2. Check the network software. 

VERICUT and the license server program use TCP/IP network protocol to 
communicate with each other, even when running VERICUT on a single stand-alone 
computer (where both VERICUT and the license server program run on the same 
computer). TCP/IP network protocol must be installed on the enabled network 
adapter that matches the Host ID encrypted in your VERICUT license. 

If you need to add TCP/IP protocol and your computer is on a company network you 
should consult with your network administrator. If you are on a computer with no 
network connection and you need help on how to add TCP/IP protocol, see the 
section, Basic Windows Network Configurations. 

 



 

Checks for the License Server Computer 
 
1. Serving licenses to other client computers. 

In addition to having a network adapter and TCP/IP network protocol installed, the 
license server computer must have a valid IP address in order to serve licenses to 
other computers. A static IP address should be used. If a dynamic IP address is 
assigned using a DHCP server, then VERICUT license check-out on client computers 
may be slow and/or inconsistent. Static IP addresses are required for all license server 
computers in a redundant server configuration. 

Use the ipconfig command to verify there is an enabled network adapter with TCP/IP 
protocol installed and that it is properly configured to be the license server computer. 
Type the following command in a command prompt window (also called a 'DOS' 
window): 

ipconfig /all 
 

The ipconfig command returns information about your computer's network 
configuration. Only a few items are important for your VERICUT installation. If your 
computer is connected to a network and TCP/IP protocol is installed and configured 
correctly, the following lines should have values in order for the license server 
program to provide licenses to VERICUT on another computer: 

        Host Name . . . . . . . . . . . .   : mycomputer 

        Physical Address. . . . . . . . .  : 00-0B-AB-77-34-64 

        IP Address. . . . . . . . . . . .   : 199.1.1.123 

        Subnet Mask . . . . . . . . . . .   : 255.255.255.0 
 
2. No network connection, stand-alone configuration. 

If your computer is not connected to a network, or your computer is sometimes 
disconnected from a network when you want to use VERICUT (thus it is a stand-
alone configuration with VERICUT and the license server program running on the 
same computer), then at a minimum you must have an enabled network adaptor. 

When disconnected from a network, ipconfig may not display an IP address. This 
does not cause a problem for VERICUT or the license server program because the IP 
loopback address (127.0.0.1) is used automatically. A Host Name is required, but the 
default name, "localhost" is sufficient. 

The following values should be displayed by ipconfig for a stand-alone 
configuration:  

        Host Name . . . . . . . . . . . .   : mycomputer (or localhost) 

        Physical Address. . . . . . . . .  : 00-0B-AB-77-34-64 



 

Checks for VERICUT Client Computers 
1. Set the optimum color display for VERICUT 

True or high color display provides optimum VERICUT performance. Desktop color 
display is changed by opening the Display icon in the Control Panel, or by right-
click > Properties on the desktop. 

NOTE:  The following checks are not necessary for a stand-alone configuration 
where VERICUT and the license server program run on the same computer. 

 
2. Check the VERICUT client computer's network software configuration. 

In addition to having a network device and TCP/IP network protocol installed, the 
device must have a valid IP address (either statically assigned, automatically created, 
or dynamically provided by a DHCP server). 

Use the ipconfig command to verify that there is an active network device with the 
TCP/IP protocol installed and that it is properly configured with a host name and IP 
address. Open a command prompt window (also called a 'DOS' window) and type: 

ipconfig /all 
 

The ipconfig command returns information about your computer's network 
configuration. Only a few items are important for your VERICUT installation. If your 
computer is connected to a network, and TCP/IP protocol is installed and configured 
correctly, the following lines must have values in order for VERICUT to work 
correctly: 

 Host Name . . . . . . . . . . . .   : mycomputer 

 Physical Address. . . . . . . . .  : 00-0B-AB-77-34-64 

 IP Address. . . . . . . . . . . .   : 199.1.1.123 

 Subnet Mask . . . . . . . . . . .   : 255.255.255.0 
 

3. Verify client and license server computers can communicate with each other. 
Both client and license server computers must have host names and valid IP 
addresses. The mechanism for assigning host names and IP addresses varies with the 
network configuration. See your site's network administrator if you are not familiar 
with how your network is configured. 

The easiest way to verify communication between computers is to "ping" each one 
from the other.  Open a command prompt window and type: 

ping COMPUTER1 
(where 'COMPUTER1' is the host name of the computer you need to 
communicate with) 

 



 

If the computers can communicate you should see something like: 

Pinging COMPUTER1 [199.1.1.123] with 32 bytes of data: 

  

Reply from 199.1.1.123: bytes=32 time=48ms TTL=127 

Reply from 199.1.1.123: bytes=32 time=46ms TTL=127 

Reply from 199.1.1.123: bytes=32 time=43ms TTL=127 

Reply from 199.1.1.123: bytes=32 time=41ms TTL=127 

  

Ping statistics for 199.1.1.123: 

    Packets: Sent = 4, Received = 4, Lost = 0 (0% loss), 

Approximate round trip times in milli-seconds: 

    Minimum = 41ms, Maximum = 48ms, Average = 44ms 

 

You should ping the client from the license server computer and the license server 
computer from the client since both computers must know about each other for proper 
communication. If the ping test fails contact your site's network administrator to 
correct the problem. 

In some network configurations there may be a router, gateway or other network device 
that acts like a firewall between the client and license server computer. In this case, the 
ping test will succeed but licensing will fail since the router or firewall must be 
configured to allow TCP/IP to pass UDP packets through port 5093. For this and other 
complex network configurations contact your site's network administrator and see the 
Sentinel RMS License Manager System Administrator's Guide, for more information 
about configuring the Sentinel RMS license server and clients. A pdf version of this 
document is available directly on the VERICUT CD in the file SLM71sys.pdf. 

 

Return to Installation Steps. 

 

http://cgtech.com/support/sentinel/administration


 

 

Basic Windows Network Configurations 
 

Use the appropriate section below to properly configure your network device for 
VERICUT on Windows computers. 

 

Check for network software on Windows 2000: 
1. Click Taskbar: Start > Settings > Network and Dial-up Connections > Local Area 

Connection. 

2. Installed software must include "Internet Protocol (TCP/IP)". Add the TCP/IP 
protocol if it is missing. 

3. Under The following network components are installed, highlight "TCP/IP". 

4. If multiple TCP/IP components are installed, highlight the component bound to the 
ethernet card, press Properties, then click the IP Address tab. Select Specify an IP 
address. Ensure that a valid network IP Address and Subnet Mask are defined. If not, 
enter IP Address=199.1.1.1, Subnet Mask=255.255.255.0 When the computer is 
setup in a network use the actual IP Address and Subnet Mask that define the node on 
the network. 

5. Press OK, and then on the Network window, press OK. 

If directed, follow prompts for loading media. If the error “The System has 
detected a conflict for IP Address 199.1.1.1 ...” appears, change the IP Address, 
for example: 199.1.1.2. 

 
To check for network software on Windows XP Professional: 
When using Start Menu, 

1. Taskbar: Start > Control Panel > Network Connections 
2. Double click on the Device icon. 
3. Select Support tab. 

Installed software must include "Internet Protocol TCP/IP". 

 

When using "classic" Start Menu, 

1. Taskbar: Start > Settings > Network Connections 
2. Double click on the Device icon. 
3. Select Support tab 

Installed software must include "Internet Protocol TCP/IP". 

 



 

 

Check UNIX Network Configuration 
 

In any VERICUT installation there is a computer that functions as the license server 
computer. There are also one or more client computers that run VERICUT and 
communicate with the license server computer to get licenses. In a stand-alone 
configuration the license server computer and the VERICUT client computer are one-in-
the-same, but the same network communication requirements apply. The following 
checks ensure that the license server computer and the VERICUT client computer(s) can 
communicate, and that the VERICUT client computers can successfully run VERICUT. 

 

Verify the client and license server computers can communicate with each other. 
Both client and license server computers must have host names and valid IP addresses. 
The mechanism for assigning host names and IP addresses varies with the network 
configuration, but most UNIX system use the /etc/hosts file to specify host names and IP 
addresses on a network. See your site's network administrator if you are not familiar with 
how your network is configured. 

The easiest way to verify communication between computers is to "ping" each one from 
the other.  In a UNIX terminal shell type: 

ping COMPUTER1 
(where 'computer1' is the host name of the computer you want to communicate with) 

 

If the ping command is not found, you can try /usr/sbin/ping. 

Different UNIX systems produce different results from the ping command. If the 
computers can communicate you will see something simple like: 

COMPUTER1 is alive 
 

Or, you may see a stream of data like: 

Pinging COMPUTER1 [199.1.1.123] with 32 bytes of data: 

 

Reply from 199.1.1.123: bytes=32 time=48ms TTL=127 

Reply from 199.1.1.123: bytes=32 time=46ms TTL=127 

Reply from 199.1.1.123: bytes=32 time=43ms TTL=127 

Reply from 199.1.1.123: bytes=32 time=41ms TTL=127 

. 

. 



 

 

You should ping the client from the license server computer and the license server 
computer from the client since both computers must know about each other for proper 
communication. If the ping test fails contact your site's network administrator to correct 
the problem.  

 

If you do not have a network or system administrator, and you have access to the 'root' 
login, you can modify the /etc/hosts file in order to establish communication between the 
license server computer and the client computers. See the section, UNIX hosts File for 
basic hosts file configuration instructions.  

 

In some network configurations there may be a router, gateway or other network device 
that acts like a firewall between the client and license server computers. In this case, the 
ping test will succeed but licensing will fail since the router or firewall must be 
configured to allow TCP/IP to pass UDP packets through port 5093. For this and other 
complex network configurations contact your site’s network administrator and see the 
Sentinel RMS License Manager System Administrator's Guide for more information 
about configuring the Sentinel RMS license server and clients. 

http://cgtech.com/support/sentinel/administration


 

 

UNIX Hosts File 
For server/client communication each computer must have an entry the other computer's 
"hosts" file. The lack of an entry in the hosts file is the most common reason the "ping" 
command fails to communicate. 

The hosts file is typically configured using the computer's management utility program, 
such as SAM on HPUX or SMIT on IBM RS6000. However, if these programs are 
unavailable, and the network configuration is simple (ie does not use other network 
services), it is possible to edit each computer's hosts file, typically located in /etc/hosts. 

NOTE:  This file can only be modified by a "root" user. 

 
Edit the /etc/hosts file 
On the license server computer, open the /etc/hosts file in a plain text editor, such as vi. 

If the host name of the client computer(s) do not exist, add a line for each client. The 
hosts file is a simple plain text file with each line consisting of a computer’s IP address 
and host name, as follows: 

127.0.0.1  localhost 

199.1.2.100 computer1 

199.1.2.101 computer2 

 

Edit the /etc/hosts file for each client computer, adding a line for the license server 
computer.  

NOTE:  If you do not know the IP address of the license server computer, you can use 
the ping command while logged-in on the license server computer. In a terminal or 
command shell, type: 

ping mycomputer 
Where 'mycomputer' is the name of the license server computer. 

If ping is not in your execution path, you can try /usr/sbin/ping. If the ping 
command does not display the IP address of the license server computer, try ping 
with the –s option. 

 

Verify client and license server computers can communicate with each 
other 
Both client and license server computers must have host names and valid IP addresses. 
The mechanism for assigning host names and IP addresses varies with the network 
configuration, but most UNIX system use the /etc/hosts file to specify host names and IP 



 

addresses on a network. See your site’s network administrator if you are not familiar with 
how your network is configured. 

The easiest way to verify communication between computers is to “ping” each one from 
the other.  In a UNIX terminal shell type: 

ping COMPUTER1 
(where 'computer1' is the host name of the computer you want to communicate with) 

 

If the ping command is not found, you can try /usr/sbin/ping. 

Different UNIX systems produce different results from the ping command. If the 
computers can communicate you will see something simple like: 

COMPUTER1 is alive 
 

Or, you may see a stream of data like: 

Pinging COMPUTER1 [199.1.1.123] with 32 bytes of data: 

Reply from 199.1.1.123: bytes=32 time=48ms TTL=127 

Reply from 199.1.1.123: bytes=32 time=46ms TTL=127 

Reply from 199.1.1.123: bytes=32 time=41ms TTL=127 

. 

. 
  

You should ping the client from the license server computer and the license server 
computer from the client since both computers must know about each other for proper 
communication. 

In some network configurations there may be a router, gateway or other network device 
that acts like a firewall between the client and license server computer. In this case, the 
ping test will succeed but licensing will fail since the router or firewall must be 
configured to allow TCP/IP to pass UDP packets through port 5093. For this and other 
complex network configurations contact your site’s network administrator and see the 
Sentinel RMS License Manager System Administrator's Guide, for more information 
about configuring the Sentinel RMS license server and clients. A pdf version of this 
document is available directly on the VERICUT CD in the file SLM71sys.pdf. 

 

 

Return to Installation Steps. 

http://cgtech.com/support/sentinel/administration


 

Mount a UNIX CD 
 

The CD-ROM drive must be mounted with "read" and "execute" access to run the 
VERICUT installation program. Some systems, may automatically mount the CD without 
the proper access and must be dismounted and re-mounted manually 

 
To see if your CD-ROM drive is mounted with proper access: 
 

• Use the "df" command to list mounted file systems. If mounted, the device name 
will appear under the "Filesystem" heading (beginning with "/dev") and the mount 
directory will appear under the "Mounted on" heading (e.g. "/cdrom" or 
"/CDROM"). 

• If /cdrom has "read" and "execute"— return to the previous installation task. 

• If /cdrom does NOT have "read" and "execute — Unmount the incorrectly 
mounted device using the "umount /CDROM" command. 

 
Mounting UNIX CD-ROM drives with "read" and "execute" access: 
In the example mount commands below "/cdrom" represents the mount directory for the 
CD-ROM drive. Substitute "#" with the SCSI ID of your CD-ROM drive. After 
mounting, verify the device is mounted via the "df" command, as described above. 

 

Tips: 
• Avoid typing errors by cutting and pasting device names. 
• If the "mount" command is not in your execution path, try "/etc/mount". 

 

Computer Type UNIX mount command 

HP See HPUX CD Mounting Instructions below. 

IBM mount -vcdrfs -r /dev/cd0 /cdrom (or use SMIT to mount) 

Solaris Volume Manager should auto-mount the CD. If not, try: 

mount -r -F hsfs /dev/dsk/c0t#d0s2 /cdrom  

 



 

 
HPUX CD Mounting Instructions 
 
VERICUT's CD installation on HPUX requires the CD to be mounted with Rockridge 
extensions. Use the following commands to mount the VERICUT CD: 
 

1. Make sure the directory containing the PFS utilities (/usr/sbin) is in your 
execution PATH.  

 
2. Edit (or create) the /etc/pfs_fstab file to contain a line like this: 
 

<device> <mount_dir> pfs-rrip xlat=rrip 0 0  
 

Where:  
 

<device> is the path to your CD-ROM drive (e.g. /dev/dsk/c1t2d0)  
 

<mount_dir> is the path to an *existing* directory where the CD-ROM 
will be mounted (e.g. /rr_cdrom)  

 
3. Type the following in a command shell:  
 

# nohup pfs_mountd &  
# nohup pfsd 4 &  

 
NOTE:  To permanently enable Rockridge these daemons can be started from 
an rc script. 

 
4. Mount the drive with the command:  

 
pfs_mount <device> | <mount_dir>  
 

You can now continue with the VERICUT installation. When you are finished with the 
install you can unmount the CD with:  

 
pfs_umount <device> | <mount_dir>  

 
Additional information on mounting a CD with Rockridge extension on HPUX can be 
found at http://www.faqs.org/faqs/hp/hpux-faq/section-87.html. 
 

Return to Installation Steps. 

http://www.faqs.org/faqs/hp/hpux-faq/section-87.html


 

 

Move Your License Server to Another Computer 
 

Choose one of the following: 

Move Windows License Server – See below. 

Move UNIX License Server 

 

Move Windows License Server 
 

It is sometimes desirable (or necessary), due to hardware upgrades or network changes, to 
move your VERICUT license server to a different license server computer. To move the 
license server in an existing installation, do the following: 

1. Request a license for the new license server computer using CGTech's on-line license 
Transfer Request form.  

(Once you receive the license email containing your new license keys, continue 
with the following steps.) 

2. Stop and Remove the Windows License Server. 

3. Follow the Installation Steps to install VERICUT on the new license server computer. 

4. Modify VERICUT client computer installations to use the newly installed license 
server computer. 

 

Do step 4 for each VERICUT installation in your network. 

 

Return to Installation Steps. 

 

http://cgtech.com/usa/support/license/license-transfer-request


 

 

Move UNIX License Server 
 

It is sometimes desirable or necessary to move your VERICUT license server to a 
different license server computer, due to hardware upgrades or network changes. To 
change license servers in an existing installation, do the following: 

1. Request a license for the new license server computer using CGTech's on-line license 
Transfer Request form.  

(Once you receive the license email containing your new license keys, continue 
with the following steps.) 

2. Stop and Remove the UNIX License Server. 

3. Follow the Installation Steps to install VERICUT on the new license server computer. 

4. Modify VERICUT client computer installations to use the newly installed license 
server computer. 

 

Do step 4 for each VERICUT installation in your network. 

 

Return to Installation Steps. 

 

http://cgtech.com/usa/support/license/license-transfer-request


 

 

Modify VERICUT to Use a Different License Server 
Computer 
 

Choose one of the following: 

Modify VERICUT on Windows to Use a Different License Server Computer – 
See below. 

Modify VERICUT on UNIX to Use a Different License Server Computer 

  

Modify VERICUT on Windows to Use a Different 
License Server Computer 
To change an existing VERICUT Windows installation to access VERICUT licenses on a 
different license server computer: 

1. Select Start > All Programs > CGTech VERICUT x.x > License Utilities > 
Specify License Server Computer (opens the file in Notepad) 

2. Change the line: 

set LHOST=server1 

3. Replace "server1" (or the name of your old license server computer) with the host 
name of the new license server computer. 

2. Save the file cgtenv.bat. 

 

Return to Installation Steps. 



 

 

Modify VERICUT on UNIX to Use a Different License 
Server Computer 
To change an existing VERICUT UNIX installation to access VERICUT licenses on a 
different license server computer: 

1. Edit the file cgtenv in the VERICUT  …/platform/commands directory. 

2. Change the line:  LSHOST=server1; export LSHOST 

3. Replace "server1" with the host name of the new license server computer.  

4. Save the file cgtenv as a plain text file. 

 

Return to Installation Steps. 



 

 

Install VERICUT License Server Only 
 
It may be desirable to install only the license server program on the license server 
computer. 
 

Select to install only the license server program by choosing "Custom" on the Type of 
Installation install screen. Then on the Choose VERICUT Components install window, 
check only the "License" choice. Continue with the installation as directed. This choice 
only applies to a Multiple Computer or Multiple Computer Network installation. 

 

Return to Installation Steps. 



 

 

Update an Existing License 
 

Choose one of the following: 

Update a License on Windows License Server – See below. 

Update a License on UNIX License Server 

 

Update a License on Windows License Server 
These instructions assume you have received a new license from CGTech via email. If 
you have not, and you need to request a new license, see Determine the HOST ID and 
Request a License. To update your VERICUT license on a Windows license server, do 
the following (on the license server computer): 

1. Create the license file from the license email or saved text file. 
 

Select Start > All Programs > CGTech VERICUT 7.0 > License Server Only > Save 
License File from License Email. 

Drag and drop the VERICUT license email from Microsoft Outlook, or Outlook 
Express, into the Create License File panel. If you use another email program, or 
cannot access the license email from the license server computer, then save the 
license email as a "Text Only" or plain text file and drag/drop the saved file into the 
Create License File panel. 

Close the Create License File panel after the "success" message displays. 

 
2. Update the licenses on the running license server. 

Select Start > All Programs >  CGTech VERICUT 7.0 > License Server Only > 
Update Licenses on Running Server. Do not attempt to do this action unless you 
know your license server is running. If you are not sure, you can verify that the server 
is running using Start > All Programs > CGTech VERICUT 7.0 > License 
Utilities > Display Local License Servers. Your server's Host Name should appear 
in the resulting panel. 

 

If errors occur,  visit the VERICUT Users’ Forum or contact CGTech technical support 
via our website, just click on the support link. 

 

Return to Installation Steps. 
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Update a License on UNIX License Server 
 

These instructions assume you have received a new license from CGTech via email. If 
you have not, and you need to request a new license, see the Request a VERICUT 
License instructions in the section Determine the HOST ID and Request a License. To 
update your VERICUT license on a UNIX license server, do the following (on the license 
server computer):  

1. Copy the license keys from the CGTech license email to a text file. 
 

Open the license email you received from CGTech. 

Copy the license keys from the license email. DO NOT copy the entire email 
text. Start with the line that begins '# Company: ', and select all lines down to and 
including the line '# End of license '. 

Paste the lines into a plain text editor such as vi. Do not use a word processing-type 
editor like Microsoft Word. 

Save the text as a plain text file. Name the file and save it in a directory so that you 
can easily find it later. For example, save the file as 'vericut70_license_keys.txt' in 
your default login directory. This file is not used once the license keys are added to 
the license server in the next step. CGTech recommends you keep the file for archive 
purposes. 

 

NOTE:  When pasting into the plain text editor make sure that the long license key 
lines are not automatically truncated or split into separate lines.  

 
2. Add the license keys to the license server and license file using lslic. 

Add the license keys to the running license server and save them in the license file. In 
a UNIX command or terminal shell execute the 'lslic' utility program from the 
'platform/license' directory in your VERICUT installation. Continuing with our 
example from above, the command would look like: 

/usr/cgtech70/solaris/license/lslic –F /users/mylogin/vericut70_license_keys.txt 

Where /usr/cgtech70 is the VERICUT installation folder on a Sun SOLARIS 
platform. 

The license keys are loaded from the file saved in step 1D above. The –F option 
adds the keys to the license server from the specified file, and saves them in 
'cgtech.lf' located in the 'platform/license' directory in your VERICUT 
installation. 

 



 

3. Verify the license keys were successfully added to the server. 
In a UNIX command or terminal shell execute the 'lsmon' utility program from the 
'platform/license' directory in your VERICUT installation. Continuing the example 
from above, the command would look like: 

/usr/cgtech70/solaris/license/lsmon  mycomputer 
Where 'mycomputer' is the host name of the license server computer. If the license 
keys were correctly applied you should see something like the following information 
displayed by the lsmon utility: 

 

Sentinel RMS Development Kit 8.0.5.0 Application Monitor 

Copyright (C) 2006 SafeNet, Inc. 

  

[Contacting Sentinel RMS server on host "mycomputer"] 

  

License type   : " Normal License." 

Commuter License Allowed : NO 

Feature name   : "VERICUT.SUN" 

Feature version   : "7.0" 

Max concurrent user(s)  : Unlimited. 

Unreserved Tokens in use : 0 

Available unreserved         : Unlimited. 

Reserved Tokens in use       : 0 

Available reserved           : 0 

Soft limit on users          : Unlimited. 

  

License start date           : Mon Mar 15 00:00:00 2007 

Expiration date              :  License has no expiration. 

Application-server locking   : Server-locked license. 

Additive/exclusive           : Exclusive license(overrides additive licenses). 

Held licenses                 : Allowed, hold time set by application. 

Token lifetime (heartbeat)   : 300 secs (5 min(s)) 

. 

. 
(each license key should be displayed) 



 

 

Your VERICUT license is now updated. 

 

If errors occur,  visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 

Return to Installation Steps. 

 

http://cgtech.com/forum/
http://cgtech.com/


 

 

Stop and Remove a Windows License Server  
Only one license server can run on the license server computer. The license server from 
the newest installed version should be used. The old license server should be stopped and 
removed before configuring and starting the new license server. 

 

Stop and remove a Windows license server service 

NOTE:   The following must be done by an Administrator user. 

Start > All Programs > CGTech VERICUT 7.0 > License Server Only > Remove 
License Server Service 

 

Stop and remove a temporary license server process 
Right-mouse click on the SentinelLM task in the windows task bar, and choose Close. 

Remove any mechanism which might have been configured to automatically start the 
temporary server. For example, you may need to remove a shortcut to the temporary 
server startup batch file from the Start > All Programs > Startup folder. 

 

If errors occur,  visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 

Return to Installation Steps. 
 

http://cgtech.com/forum/
http://cgtech.com/


 

 

Stop and remove a UNIX license server 
NOTE:  The following must be done logged-in as the computer's 'root' user. Do not 'set 
user' (su) to root as this does not always correctly execute the root account's login 
process. 

Only one license server can run on the license server computer. The license server from 
the newest installed version should be used. The old license server should be stopped and 
removed before configuring and starting the new license server. 

As "root", stop the active license server via the "stop_server" command file located 
in the "platform/license" directory of your VERICUT software installation, where 
"platform" is one of the following: hp, rs, or solaris. 

If the license server was configured to automatically start at system boot-up, use your 
system management utility to remove the license server startup from your systems 
boot-up sequence. 

 

If errors occur,  visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 

Return to Installation Steps.

http://cgtech.com/forum/
http://cgtech.com/


 

 

Starting a Temporary Windows License Server 
  

The following describes how to start a temporary license server. But, it is strongly 
recommended that you configure the license server program to automatically start using 
Windows services. If for some reason you cannot configure the license server service, 
then it can be temporarily started.  

To start a temporary license server select: 

Start > All Programs > CGTech VERICUT 7.0 > License Server Only > Run 
Temporary License Server.  

You could add a Windows shortcut to your desktop to make access to this procedure 
easier.  

This Start menu item could also be added to the Windows Startup folder so that it 
automatically starts when you log-in. 

 

NOTES: 
1. The temporary license server process is owned by the specific user that starts it. 

When that user logs-out, the license server program terminates. 
2. Starting a temporary license server stops the Windows license server service if it 

is running. 

 

If errors occur,  visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 

Return to Installation Steps. 

http://cgtech.com/forum/
http://cgtech.com/


 

 

Starting a Temporary UNIX License Server 
  

NOTE:  The following must be done logged-in as the computer's 'root' user. Do not 'set 
user' (su) to root as this does not always correctly execute the root account's login 
process. 

The following describes how to start a temporary license server. But, it is strongly 
recommended that you configure the license server program to automatically start using 
your UNIX system manager’s utility. If for some reason you cannot configure the license 
server to start automatically, then it can be temporarily started.  

The VERICUT installation includes a UNIX script that launches the license server 
program. The script file name is "start_server" and is located in the 'platform/license' 
directory of your VERICUT installation, where platform is: hp, solaris, or rs.  

To start the license server temporarily: 

1. Open a command shell. 

2. Execute the start_server script from a command or terminal shell. 

…/cgtech70/platform/license/start_server 

 

NOTE:  The temporary license server process is owned by the "root" user that starts it. 
When that user logs-out, the license server program terminates. 
 

If errors occur,  visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 

Return to Installation Steps.

http://cgtech.com/forum/
http://cgtech.com/


 

 

Using Silent Install 
 

Silent Mode 
Silent mode, which enables an installer to run without any user interaction, is fully 
supported on all UNIX platforms. A near-silent mode is possible on Windows. If you 
choose to run this option, there will be no console or GUI output during installation. 
Silent mode supports the setting of a target directory, shortcuts directory, and 
Components/Features via either command-line arguments or a properties file. Silent 
mode is supported in both the installer and uninstaller runtime environments. 
InstallAnywhere and end-user-defined variables may be set through command-line 
parameters and/or a properties file.  

An installer properties file or a command-line parameter may trigger silent mode.  

  

Installer Properties File 
An installer properties file is an ASCII text file that defines certain parameters for your 
installation. This may be useful if you have a complex project that you are installing both 
internally and externally. Your internal end-users do not need to see panels such as the 
License Agreement panel. The properties file is an ideal way to turn panels on or off 
depending on your specific needs. In addition, the properties file can define the type of 
installation you want to run, such as console or silent.  

NOTE:  Please make sure that your properties file ends in .properties, not .txt. 

  

Tip:  If the install.properties file is in the same directory as your installer, it will be 
invoked automatically. However, if it is in a different directory or a different name, you 
may use the following command line option to direct it to the relative path: 

 C:\\ <path to the installer> -f <path to the properties file> 
  

Command Line Parameter 
To call the properties file from the command line, type the following command: 

install.exe -f <properties file> 
You may use the direct or the relative path to the properties file.  

InstallAnywhere variables may be incorporated in these values, and they will be resolved 
at install time. 

  



 

NOTES:  
1. File separators should be denoted by the "$/$" InstallAnywhere variable, or be 

escaped. 

2. Values may ignore case. 

3. Silent mode will override action panel values. 

4. In any mode on Windows systems, installers and uninstallers will always display the 
very last "Cleaning-up" dialog box, as well as the "Preparing to install" panel.  

  

VERICUT Properties File Variables 
An example of an install.properties file for a silent Partial VERICUT Millimeter 
windows installation should contain the following: 

  

INSTALLER_UI=Silent 
USER_INSTALL_DIR=C:$/$cgtech611 
CHOSEN_INSTALL_SET=Partial 
VERICUT_PLATFORMS="Windows 32-bit","" 
LICENSE_SERVER_HOSTNAME="LicenseServer" 
DEFAULT_BASE_LIC_VAR="1) VERICUT" 
DEFAULT_UNITS_VAR="","2) Millimeter" 

  

An example of an install.properties file for a silent Full VERICUT Inch windows 
installation should contain the following:  

  

INSTALLER_UI=Silent 
USER_INSTALL_DIR=C:$/$cgtech611 
CHOSEN_INSTALL_SET=Full 
VERICUT_PLATFORMS="Windows 32-bit","" 
LICENSE_SERVER_HOSTNAME="LicenseServer" 
DEFAULT_BASE_LIC_VAR="1) VERICUT" 
DEFAULT_UNITS_VAR= "1) Inch","" 

 



 

NOTES: 
1. To install Windows 32 bit platform only: 
 

VERICUT_PLATFORMS="Windows 32-bit","" 
 
2. To install Windows 64 bit platform only: 

 
 VERICUT_PLATFORMS="","Windows 64-bit" 

 
3. To install both the Windows 32 bit & 64 bit platforms: 

 
 VERICUT_PLATFORMS="Windows 32-bit"," Windows 64-bit" 

 
4. Installing on UNIX Platforms: 

 
VERICUT_PLATFORMS="HP - HP-UX","RS - IBM AIX","Solaris - Sun 
Solaris" 
 

Return to Installation Steps. 

 



 

 

Uninstall an Old Version of VERICUT 
 

Uninstalling is recommended when a VERICUT version in not needed, or when disk 
space is limited. Use the appropriate procedure below to remove a version of VERICUT 
from your computer. 

 

To remove VERICUT from a Windows computer: 
1. Remove the license server service by selecting Start > All Programs > CGTech 

VERICUT 7.0 > License Server Only > Remove License Server Service. Do this 
BEFORE uninstalling! 

2. Unistall VERICUT by selecting Start > Programs > CGTech VERICUT x.x > 
Utilities >Uninstall VERICUT x.x (where "x.x" is the version of VERICUT to be 
uninstalled) and follow the prompts of the "uninstall" program. You can also start the 
"uninstall" program using the UninstallVERICUT.exe, located in the 
UninstallerData folder of your VERICUT software installation. 

 

To remove VERICUT from a UNIX computer: 
1. Stop the license server program by executing the 

../cgtechx.x/platform/license/stop_server script in the VERICUT installation being 
removed. Where "x.x" is the VERICUT version and "platform" is the UNIX platform 
type. Do this BEFORE uninstalling! 

2. Change to the directory above where VERICUT was installed. For example, if 
installed in "/usr/cgtech60", then type: cd /usr 

3. Remove (delete) the entire tree of directories and files beginning with the CGTech 
installation directory, for example: "rm -r cgtech60" 

 

NOTE:  There may be program folder/files that are not removed by uninstalling. These 
were created after VERICUT was installed and will have to be removed manually. 

 

Return to Installation Steps. 

 



 

 

Download and Install the Latest Point Release for 
Windows 
 

VERICUT point releases for Windows are available on the CGTech web site. The 
following steps will guide you through downloading and installing a VERICUT point 
release (we'll use 6.1.1 as an example below):  

Download Instructions:                                                         

The VERICUT 6.1.1 Windows version (Windows XP, XP64, 2000) is available for 
download from our web site. Follow this link to open the on-line form to begin the 
download process: 

http://www.cgtech.com/usa/support/software-update/ 

To download the file, you will need your Company ID and the access code from the 
"VERICUT 6.1.1 is available for download" email that was sent to all customers on 
maintenance. If you are not currently on maintenance, contact your CGTech 
representative.  

 

Starting the Installation: 
After downloading the zipped installer, unzip it to a temporary folder. The zip file is 
password protected. The password was also included in the "VERICUT 6.1.1 is 
available for download" email. 

Once the files are unzipped, double-click on install.exe to begin the installation. 

 

Return to Installation Steps. 

http://www.cgtech.com/usa/support/software-update/


 

Install Microsoft redistributable C++ Run-Time 
Libraries 
 

VERICUT on XP 64 likely requires installation of the correct version of Microsoft’s C++ 
run-time libraries. To install the libraries: 

Get the vcredist_x64.exe installer: 
The redistributable C++ run-time is available 

• On the VERICUT CD. The file name is vcredist_x64.exe. 

• In the VERICUT installation in C:\CGTech70\redist\vcredist_x64.exe, 
where “C:\CGTech70\” is your installation location. 

• Download from CGTech’s ftp site at: 

ftp://ftp.cgtech.com/Download/pointrel/windows64/vcredist_x64.exe 

Installation: 
Double-click on vcredist_x64.exe to install. There are no prompts during 
installation and no confirmation of completion. 

 

Return to Installation Steps. 

 

ftp://ftp.cgtech.com/Download/pointrel/windows64/vcredist_x64.exe


 

 

Running VERICUT 5.2 or 5.3 with the current 
VERICUT License Server 
 

VERICUT 5.2 and 5.3 require an environment variable setting to specify the version of 
the license file. 

NOTE:  VERICUT 5.2.1 (or higher) is required if you want to use a later version 
license, such as a 5.3 or 5.4 license. 

For example, to run VERICUT 5.2.1 using a later VERICUT license, such as 5.4. the 
environment variable CGTECH_LICENSE_VERSION must be set to the value "5.4". 
This can be done by modifying the following file: 

\cgtech521\windows\commands\cgtenv.bat  (or the UNIX 'cgtenv') Either add or 
modify the following line at the end of the file: 

 

WINDOWS 

set CGTECH_LICENSE_VERSION=5.4 

UNIX 

CGTECH_LICENSE_VERSION=5.4; export CGTECH_LICENSE_VERSION 

 

Return to Installation Steps. 



 

 

Redundant License Server Setup 
 

Choose one of the following: 

Configure Redundant License Servers on Windows Computers – See below. 

Configure Redundant License Servers on UNIX Computers 

 

Configure Redundant License Servers on Windows 
Computers 
 

If you plan to configure redundant license servers you should have identified the three (3) 
required license server computers, provided their Host ID's to CGTech, and received a 
license email containing the special license keys for redundant license servers. You 
should also have specified the three license servers (in the order, 
leader:follower1:follower2) during the VERICUT installation. 

A redundant license server configuration requires a special license configured for three 
(3) license servers. Earlier installation instructions explained how to request the license. 
Redundant license server configuration should only be done by experienced system 
administrators with networking experience. 

NOTE:  Each redundant server must have a static IP address. Dynamic IP addresses 
cause poor performance or failure. 

 

Follow the steps below to setup a Windows redundant license server configuration. These 
steps must be done by an "Administrator" user. The steps assume you have received the 
license email from CGTech. 

1. Save License File from License Email. 
(requires privileges to write to the VERICUT installation folders) 

 

Select Start > All Programs > CGTech VERICUT 7.0.x > License Server Only > 
Save License File from License Email.  

When the Create VERICUT License File screen displays, drag and drop the 
VERICUT license email from Microsoft Outlook, or Outlook Express, into the Create 
VERICUT License File screen. If you use another email program or cannot access the 
license email from the license server computer, save the license email as a "Text 
Only" or plain text file, then drag and drop the saved file into the Create VERICUT 



 

License File screen. You can also Copy/Paste the email contents into the Create 
VERICUT License File screen.  

The Create VERICUT License File screen's text area displays all the added license 
keys, followed by the message: 

"License file C:\cgtech60x\windows\license\cgtech.lf created successfully".  

Close the Create VERICUT License File screen after the license file has been created.  

   
2. Determine the IP address of each of the 3 license servers. 

These will be used in the redundant license file configuration in the following steps. 

  

3. Use WRlfTool.exe (located in the \windows\license\ folder of your VERICUT 
installation) to create the redundant license file. 

 
Run …\windows\license\WrlfTool.exe. 

In the WRlfTool panel select File -> New. 

Press the Add Server button (in the upper half of the window).  

In Add Server to Pool panel, enter the Hostname and IP Address (or IPX Address) 
for the "leader" license server computer, and then press OK. 

Press the Add Server button two more times to add the Host Names and IP addresses 
for each of the two "follower" license server computers. All three redundant server 
host names and IP addresses should now appear in the Redundant Servers list. 

Press the Add License button (in the lower half of the window). 

In the Add Redundant License panel, select "Read License(s) from file". 

Press Browse and navigate to, and select, the cgtech.lf file you saved in step 1C 
above. Press Open, and then press OK. 

The Edit License panel opens, showing the first VERICUT license key in the 
License Code field on the right side of the panel, and the number of available 
licenses displayed in the Number of Tokens field (lower left in the panel). 

On the right side of the panel the 3 license server host names appear in the Server 
column. Check the Include checkboxes for all 3. 

Enter the value from Number of Tokens (lower left) in the Num Tokens column to 
the right of the first or "leader" server. This assigns all tokens for the displayed 
license key to the leader license server. Make sure that the Num Tokens values, for 
the two "follower" servers, is set to zero. 

Select Next License >> at the bottom of the panel to display the information for the 
next VERICUT feature. Repeat the previous step to assign all tokens for this license 
key to the leader license server. 

Repeat for each license key.  



 

Press Done at the bottom of the panel after the last license key is completed. 

Select File->Save As and save the redundant license file as "cgtech.lf" in the 
…/windows/license folder of the leader license server's VERICUT installation. 

 

4. Copy the redundant license to the other license servers. 
Copy the file cgtech.lf into the …/windows/license folder of the VERICUT 
installation on each of the other two license server computers. 

 

5. Start the License Servers. 
CGTech strongly recommends you configure the license server program to 
automatically start when you start your computer. 

 

NOTES:  
1. The license server computer requires TCP/IP network protocol installed on the 

network adaptor. See the section, Check Windows Network Configuration for 
more information. 

2. The following steps must be done by an Administrator user. 
 

On the "leader" license server computer: 
 

Select Start > All Programs > CGTech VERICUT 7.0 > License Server Only > Start 
License Server Service. This will automatically remove any existing service and add and 
start the service from the current folder. 
Select Start > All Programs > CGTech VERICUT 7.0 > License Server Only > Set 
License File Environment Variable. 
Modify the system environment variable lservopts created in the previous step.  
 

The following is one way to do it: 

1. Find the "My Computer" icon, right-mouse click on it, and select Properties. 
2. In the System Properties panel, select the Advanced tab. Press the Environment 

Variables button located near the bottom of the panel. 
3. In the Environment Variables panel, scroll the lower System Variables list, 

select LSERVOPTS, and press the Edit button. 
4. In the Edit System Variable panel change the Variable Value by replacing the 

"-s" with "-rlf" 
5. Press OK in the Edit System Variable panel, and all remaining panels. 

 
Restart the computer. 
Repeats steps A through D for the two follower computers. 
 
 



 

NOTES: 
1. Be sure to start the 3 redundant license server computers in the same order 

specified when the redundant license file was created. Starting them out-of-order 
could cause problems designating the “leader” computer and assigning tokens. 
You should wait 1 or 2 minutes between starting each license server computer to 
make sure that it is fully started and ready to communicate with the next one. 
There is no "maximum" time limit between starting the license server computers. 

 

2. When starting a redundant license server, the error message "lservrc not 
found" may display. This message can be ignored. 

 

6. Verify the license servers started. 
All 3 redundant license servers should now be running and should be configured to 
automatically start. You can confirm that the server program is running using the 
Sentinel License Administrator program. 

Select Start > All Programs > CGTech VERICUT 7.0 > License Utilities>  
Sentinel License Administrator (WlmAdmin). You should see all 3 license server 
computers' host names appear under the Defined Servers list under the 'tree' 
displayed on the left side of the window. 

If they do not display you may need to add them using Edit > Defined Server List in 
the WlmAdmin panel. In a few seconds your VERICUT licenses should appear 
under the server computer's name (you may have to expand it). 

The redundant license server computers are now configured to automatically start the 
license server program, the VERICUT license keys exist in 
…\windows\license\cgtech.lf, and the license server programs are configured to read 
VERICUT license keys from the file. 

NOTE:  During VERICUT installation you should have specified the 3 license 
servers when prompted for the license server name. If you did not enter the three 
license server host names during installation, you can modify the name by selecting 
Start > All Programs > CGTech VERICUT x.x > License Administration > 
Specify License Server Computer. When the Notepad editor opens, change the line 
"set LSHOST=..." to be: 

 

set LSHOST=hostname1:hostname2:hostname3  
Where "hostname1", etc. are the names of your 3 redundant license servers. The 
names MUST be specified in the same order used when the redundant license file 
was created. The three hostnames are separated by colons ( : ). 



 

 

7. Save the file and exit Notepad. 
 

NOTE:  For more detailed information about setting up a redundant license server 
configuration, see Chapter 3 in the Sentinel RMS License Manager System 
Administrator's Guide. A pdf version of this document is available directly on the 
VERICUT CD in the file SLM71sys.pdf. 

 

If errors occur,  visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 
Next installation task: Test VERICUT on the Windows License Server 

 
 

Return to Installation Steps. 

http://cgtech.com/support/sentinel/administration
http://cgtech.com/support/sentinel/administration
http://cgtech.com/forum/
http://cgtech.com/


 

 

Configure Redundant License Servers on UNIX 
Computers 
 

If you plan to configure redundant license servers you should have identified the three (3) 
required license server computers, provided their Host ID's to CGTech, and received a 
license email containing the special license keys for redundant license servers. You 
should also have specified the three license servers (in the order, 
leader:follower1:follower2) during the VERICUT installation. 

A redundant license server configuration requires a special license configured for three 
(3) license servers. Earlier installation instructions explained how to request the license. 
Redundant license server configuration should only be done by experienced system 
administrators with networking experience. 

NOTE: Each redundant server must have a static IP address. Dynamic IP addresses 
cause poor performance or failure. 

Follow the steps below to setup a UNIX redundant license server configuration. These 
steps must be done by a "root" user. The steps assume you have received the license 
email from CGTech. 

1. Save the license email to a text file. 
 

Open the license email you received from CGTech. 
Copy the license keys from the license email. DO NOT copy the entire email 
text. Start with the line that begins '# Company: ', and select all lines down to and 
including the line '# End of license '. 
Paste the lines into a plain text editor such as vi. Do not use a word processing-type 
editor like Microsoft Word. 
Save the text as a plain text file. Name the file and save it in a directory so that you 
can easily find it later. For example, save the file as 
'/users/mylogin/vericut60_redundant.txt ' in your default login directory. This file 
is not used once the license keys are added to the license server in the next step. 
CGTech recommends you keep the file for archive purposes. 

NOTE:  When pasting into the plain text editor make sure that the long license key 
lines are not automatically truncated or split into separate lines. 

 
2. Determine the IP address of each of the 3 license servers. 

These will be used in the redundant license file configuration in the following steps. 



 

 
3. Use the "rlftool" program (located in the …/platform/license/ folder of your 

VERICUT installation) to create the redundant license file. 
 

Run …/platform/license/rlftool in a command or terminal shell. 
Using the rlftool menus, enter the host name and IP address for the "leader" and 
"follower" license server computers. 
 

[RLFTOOL MAIN MENU] 

Select 1…3:  2 (Add/Delete Server) 

[SERVER MENU] 

Select 1…3: 1 (Add New Server)  

Enter server name:  host name 

Enter IP(IPX) address of server:  IP  address 

Do you want to add this server?(Y/n):  y 

(repeat SERVER MENU choices to add the server name and IP address for the 
second license server computer) 

(repeat SERVER MENU choices to add the host name and IP address for the third 
license server computer) 

Select 1…3: 3 (Back to Main Menu).  

 
In the rlftool menus, add licenses from the file saved in step 1 above. 
 

[RLFTOOL MAIN MENU] 

Select Option (1..12): 7 (Add License) 

[ADD LICENSE MENU] 

Select Option (1..3): 1 (Pick Licenses from file) 

Enter File Name: (enter the path and file name of the file you created in step 1) 

Identify and distribute license tokens 

After you enter the file name above, information related to the first license key in 
the file will display. Follow the prompts to assign all the license "tokens" to the 
"leader" license server computer. 

Repeat for each of the license keys in the file.  

When finished, enter 3 (Back to Main Menu). 



 

 
Save the redundant license file and exit. 
 

[RLFTOOL MAIN MENU] 

Select Option (1..12): 12 (Exit and Save)  

 
The rlftool program automatically saves the redundant license file as "lservrlf" in 
your current working directory. 

 
4. Copy the redundant license file to all 3 license server’s VERICUT installations. 

Copy the file lservrlf to …/platform/license/cgtech.lf for all 3 redundant license 
server's VERICUT installations. 

 

5. Modify the start_server script to use a redundant license. 
Edit the script file "…/platform/license/start_server" in the leader license server's 
VERICUT installation, where platform is: hp, solaris, or rs. Change the following line 
by replacing the "-s" option with "-rlf". 

 

$CGTECH_PRODUCTS/license/lserv   -rlf   
$CGTECH_PRODUCTS/license/cgtech.lf 

 
6. Configure and Start the "leader" License Server. 

CGTech strongly recommends you configure the license server program to 
automatically start when you start your license server computer. The method for 
doing this depends on your particular UNIX platform and how your system’s 
administrator prefers to manage the computer's startup process. Most UNIX systems 
use their own graphical system management utility program, such as SAM for HPUX 
or SMIT for IBM RS6000/AIX, to configure the computer’s startup processes. 

 

NOTE FOR UPDATE INSTALLATIONS:  

Before beginning the license server configuration, be sure to stop the existing 
VERICUT license server running on the license server computer. If you have 
automated the license server startup, remove it from your system's startup 
configuration using your systems’ management utility program. Only one Sentinel 
RMS license server program may run on a computer. 

Add the start_server script to the license server computer's startup processes using 
your platform's system management utility. If your platform's system management 
utility gives you a choice, add the license server startup after the network services 
startup. 



 

Reboot the leader license server computer after adding the license server program to 
your system's startup process to verify that it starts correctly upon reboot. If it is not 
possible to reboot your license server computer now, start the license server program 
manually using your platform's system management utility. 

7. Configure and Start the Remaining 2 "follower" License Servers 
Configure and start the license server on the remaining 2 "follower" license servers, 
as you did for the "leader" license server in the steps 5 and 6. 

 

NOTES:  
1. Be sure to start the 3 redundant license server computers in the same order 

specified when the redundant license file was created. Starting them out-of-
order could cause problems designating the "leader" computer and assigning 
tokens. You should wait 1 or 2 minutes between starting each license server 
computer to make sure that it is fully started and ready to communicate with 
the next one. There is no "maximum" time limit between starting the license 
server computers. 

2. When starting a redundant license server, the error message " lservrc not 
found" may display . This message can be ignored. 

 

8. Verify the license servers started. 
All 3 redundant license servers should now be running and should be configured to 
automatically start. A utility program is provided to detect the license server, called 
'lswhere', and is located in the 'platform/license' directory of your VERICUT 
installation. Execute the lswhere program from a command or terminal shell to 
determine if the license server program is running. For example, if your license server 
computer is a Sun computer running the SOLARIS operating system, and VERICUT 
is installed in the /usr/cgtech60 directory, then type the following command: 

/usr/cgtech60/solaris/license/lswhere 
 

If the license server is running you should see the following information displayed by 
the lswhere utility: 

 
Sentinel RMS Development Kit 8.0.5.0 Search Tool For License Servers Copyright 
(C) 2006 SafeNet, Inc.  

Server Address     : 199.1.1.123 

Server Name        : mycomputer 

(in this example the server computer's host name is 'mycomputer' and its IP 
address is 199.1.1.123) 

 



 

All 3 redundant servers should display. 

The redundant license server computers are now configured to automatically start 
the license server program. 

NOTE:  During VERICUT installation you should have specified the 3 license 
servers when prompted for the license server name. If you did not enter the three 
license server host names during installation, you can modify the names by 
editing the file …/platform/commands/cgtenv in each VERICUT installation. 
Change the line 

LSHOST= hostname1:hostname2:hostname3; export LSHOST  
Where "hostname1", etc. are the names of your 3 redundant license servers. The 
names MUST be specified in the same order used when the redundant license file 
was created. The three hostnames are separated by colons ( : ).  

 
9. Save the file. 
 

NOTE:  For more detailed information about setting up a redundant license server 
configuration, see Chapter 3 in the Sentinel RMS License Manager System 
Administrator's Guide. A pdf version of this document is available directly on the 
VERICUT CD in the file SLM71sys.pdf. 

 

If errors occur,  visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 
Next installation task: Test VERICUT on a UNIX license server computer 

 

Return to Installation Steps. 

 

http://cgtech.com/support/sentinel/administration
http://cgtech.com/support/sentinel/administration
http://cgtech.com/forum/
http://cgtech.com/


 

 

Configuring CAD/CAM to VERICUT Interfaces 
 

Choose the interface you want to configure from the following: 

CATIA-to-VERICUT Interface (CATV) for CATIA version 4 

CATIA V5-to-VERICUT Interface for CATIA version 5 

EdgeCAM-to-VERICUT Interface 

GibbsCam-to-VERICUT Interface (GibbsV) 

Mastercam-to-VERICUT Interface (MCAMV)  

NX-to-VERICUT Interface (NXV) 
 



 

 

Configuring the CATIA-to-VERICUT Interface 
(CATV) for CATIA version 4 
 

This section documents supported versions of CATIA, and the procedure for configuring 
CATV. 

 

CATIA version support 
CATV can be operated on the UNIX computers with the CATIA systems listed below. 

Hardware 
vendor: 

Supported CATIA versions: 

HP CATIA 4.1.4-4.1.5 (no patches required) 

CATIA 4.1.6 or higher with "Best Available" PTF or latest "Refresh" 
package 

IBM CATIA 4.1.2 with PTF UB14570, UB14571 

CATIA 4.1.3 with PTF UB14543 or UB16141 

CATIA 4.1.4-4.1.5 (no patches required) 

CATIA 4.1.6 or higher with "Best Available" PTF or latest "Refresh" 
package 

Solaris CATIA 4.1.8 or higher with latest "Refresh" package 

  

CATIA load modules 
The following programs or load modules are required to support the CATV product 
within CATIA, and are listed in the suggested order of installation: 

BASE 

3D_DESIGN 

Exact Solids (CATIA 4.1.2 only) 

  

CATV configuration 
Follow the general procedure below to configure CATV. System-related steps may 
require "root" permissions to accomplish-see your system administrator for assistance. 



 

1. Assuming CATIA has already been installed, install VERICUT (includes the 
CATV software) per the VERICUT installation instructions. 

IMPORTANT!  CATIA requires that the directory path to CGTech 
product licensing be a maximum of 24 characters. Choose an 
installation directory for CGTech products that does not violate this 
requirement or CATV may not operate correctly. For example, 
installing VERICUT on an RS computer in the "/usr/cgtech" directory 
provides a 22 character path: "/usr/cgtech/rs/license". 

2. Edit the "CATIA.dcls" Declarations file (located in the "catv/dec" directory) to 
declare directories CATV can write files to. 

CATV must be able to write files during export and transfer operations. By 
default, the user's home and present working directories are declared for CATV 
access. Edit the "Output files for CATV" section in the CATIA.dcls file to add 
any additional directories you want CATV to be able access. 

Example edited "Output files for CATV" section in a CATIA.dcls file (added 
directory "/users/user2/CATIA"): 

: 
/* Output files for CATV */ 
alias VCN00001 = catia.VCNFILES = ‘$PWD’; 
alias VCN00002 = catia.VCNFILES = ‘$HOME’; 
alias VCN00003 = catia.VCNFILES = `/users/user2/CATIA'; <== added 
this entry 
/* DO NOT MODIFY BELOW THIS LINE; reserved for CATV */ 
: 

3. Incorporate CATV into your normal CATIA environment. One way to do this is 
to append the Declarations file ".../catv/dcls/CATIA.dcls" to the "USRENV.dcls" 
file in each user's local directory. 

4. Start CATIA with CATV. 

After completing the previous step and assuming VERICUT is licensed and 
operational, you should be able to start CATIA with CATV via your usual means. 
If CATIA does not start, DO NOT CONTINUE-see your CATIA system 
adminstrator for assistance. 

5. In CATIA, add the "CATV" function to the CATIA keyboard, for example: 

a. From the CATIA FILE menu, select the KEYBOARD function. 

b. Choose CATV from the list of available functions. 

c. Choose a location on the CATIA keyboard where the CATV function is to 
reside. 



 

Once configured in this manner, CATV should remain accessible for subsequent CATIA 
sessions. 

  

Translating CATV text 
The "VCNCATIN.dcls" Declarations file (located in the "catv/dec" directory) contains 
declarations for text appearing in CATIA resulting from CATV usage. This file provides 
the National Language Support ("NLS") capability for CATV. By default, the 
VCNCATIN.dcls file provides English language text. However, the file can be edited 
similar to editing CATIA NLS files to change the CATV user interface character set. 

  

Configuring CATV to start VERICUT with a custom User file 
By default, CATV initializes VERICUT with the "init.usr" (inch CATIA sessions) or 
"initm.usr" (mm CATIA sessions) Library file, prior to adding CATIA data transferred 
by the interface: models, tool path(s), etc. You can change the User file CATV starts 
VERICUT with by setting the CGTECH_VCUSR environment variable in the "catv" 
command file prior to the entry that executes CATIA. The command files are located in 
the "computertype/commands" where "computertype" represents the computer type on 
which CATV is to be run (e.g. "rs/commands") 

Example edited "catv" command file (added CGTECH_VCUSR entry): 

: 
elif [ "`uname`" = "AIX" ] ; then 

  LIBPATH=$LIBPATH:$CATV/steplib 

  export LIBPATH 

  STEPLIB=$LIBPATH 

  export STEPLIB 

fi 

CGTECH_VCUSR=/usr/myfiles/myuserfile.usr; export CGTECH_VCUSR <== 
added this entry 
catini -XM 

<end of file> 

  

Configuring CATV to transfer non-CATIA binary tool paths 
CATV has a built in Binary APT Converter. By default the converter processes CATIA 
binary tool paths via the CAT CLF function in the TOOLPATH menu. Environment 
variables in the "catv" command file control the type of binary tool path file that can be 
processed, and other aspects of binary tool path conversion. The command files are 



 

located in the "computertype/commands" where "computertype" represents the computer 
type on which CATV is to be run (e.g. "rs/commands"). 

The environment variables listed below provide control over transferring binary tool 
paths with CATV. 

BINCL2V_CLTYPE={1 | 2 | 3 | 4} — Sets the binary tool path file type for interpreting 
binary CL-file data, where “n” specifies the following tool path file types: 

1= IBM Mainframe APT 

2= Workstation IBM APT 

3= Workstation CATIA APT (default) 

4= VAX APT 

When the default binary tool path type is specified (BINCL2V_CLTYPE=3), the 
remaining binary conversion environment variables are ignored. When 
BINCL2V_CLTYPE=1, 2 or 4, the variables below are applied. 

 

BINCL2V_TABLE=<tablefile> — Specifies the APT Table file used to interpret the 
binary CL data. The full directory path can be included with the file name. (Default: 
BINCL2V_TABLE=$CGTECH_PRODUCTS/bincl2v/aptwords.tbl where the 
CGTECH_PRODUCTS environment variable has been previously set to specify where 
CGTech products have been installed) 

 

BINCL2V_CIRCLES={YES | NO} — Controls if circular motions are to be represented 
by CIRCLE records or chordal GOTO records. YES (default) uses CIRCLE records. No 
uses chordal GOTO records. 

 

BINCL2V_HEIGHT=<minimumcutterheight> — Specifies a minimum cutter height 
to be used for cutter descriptions having height less than this value. (Default=0) 

 

If errors occur, visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 

You should now be ready to start using the CATIA-to-VERICUT Interface. For complete 
details on using the CATIA-to-VERICUT Interface, see CATIA-to-VERICUT 
Interface (CATV), in the CAD/CAM Interfaces section of Converters and CAD/CAM 
Interfaces, located in the CGTech Help Library. 

 
 

Return to Installation Steps. 

http://cgtech.com/forum/
http://cgtech.com/


 

 

Configuring the CATIA V5-to-VERICUT Interface 
 

Prerequisites 
CATV 7.0 requires CATIA V5 (R16 or later) and VERICUT 7.0 (or later). It is only 
available for the 32bit and 64bit Windows platforms.  

It also requires two elements of Windows. 

1. "Windows Script" should be version 5.6 or later. The latest version of Windows 
Script is available from Microsoft's download site. Search for "Windows Script" 
and pick the latest version offered.  Note that there is one download for Windows 
2000 and XP, and another for 98, ME and NT.  

2. Two dynamic link libraries, FM20.dll and FM20ENU.dll, which are distributed 
with Microsoft Office. If some portion of Office is installed then FM20.dll and 
FM20ENU.dll should already be present (in the "Windows\System32" folder or 
an equivalent) and registered. 

 

Configuration 
The CGTech software installation procedure places the files required by CATV in a sub-
folder. If you elected to install the software in the default folder "C:\CGTechxx" (where 
xx is the VERICUT release number), then for VERICUT 7.0, the CATV folder will be 
"C:\cgtech70\windows\catv5" or "C:\cgtech70\windows64\catv5".  

One of the files is "CATV.bat", which sets at least two environment variables before 
invoking the executable "CATV.exe". The first environment variable is 
CGTECH_PRODUCTS and it points to the platform specific folder of the CGTech 
software. For CATV the platform is either "windows" or "windows64". The second 
environment variable is CGTECH_LIBRARY and it points to the folder containing 
VERICUT specific files distributed with the product. These include "init.VcProject" and 
"initm.VcProject" which are used by "CATV.exe" as project and setup templates if no 
other file is specified by the user. "CATV.bat" is generated during the installation 
procedure and there should be no need to edit the definition of either of these mandatory 
environment variables.  

The first of the optional environment variables in the batch file is 
CGTECH_CATV_LANGUAGE. If you want CATV's interface to use something other 
than US English, the variable can specify a file of localized text. Versions for French and 
German are supplied.  

http://www.microsoft.com/downloads


 

The second optional environment variable is CGTECH_CATV_FOLDER. CATV 
generates a number of files when it communicates the details of a CATIA CATProcess 
file to VERICUT. These include tool libraries, STL or VRML model files, and NC 
programs in APT or G-Code. Normally CATV will offer to place these files in the same 
folder as the CATProcess file. You can override this behavior interactively, but if you 
typically want all generated files to be placed in a single (perhaps temporary) folder, you 
can use this environment variable to specify it.  

You can place a shortcut to the CATV batch file on your Windows Desktop. If you do 
so, we suggest that you alter the properties of the shortcut so that it runs in a minimized 
window. This will avoid having an almost empty command window on screen for the 
batch process. An alternative is to trigger the batch file from an icon on one or more of 
CATIA's toolbars. To assist in setting this up, there is a CATIA macro script in the 
CATV5 folder, called "CATV.CATScript". There are two icon files in sub-folders, 
"Small\I_CATV.bmp" and "Normal\I_CATV.bmp".  

If you wish to have an icon ( ) on a CATIA toolbar, the two icon files must be placed 
where CATIA expects to find them. The paths depend on where you have CATIA 
installed, but typically you will find a "small" and "normal" folder under "C:\Program 
Files\Dassault Systemes\B16\intel_a\resources\graphic\icons". Place the two versions of 
the CATV icon, both called "I_CATV.bmp", in the appropriate folders.  

Adding the CATV icon ( ) to a CATIA toolbar is a multi-step process; 

1. Get CATIA V5 running.  
2. Make the "Advanced Machining" workbench active, either by accessing an 

existing CATProcess file, or by initializing a new one. One or more of the 
Manufacturing toolbars are likely to be suitable locations for the CATV icon.  

3. Pick "Tools" > "Macro" > "Macros" from CATIA's menus.  
4. In the "Macros" dialog, pick "Macro Libraries".  
5. In the "Macro Libraries" dialog, set the "Library Type" to "Directories".  
6. Pick "Add existing library ..." and select the folder containing the 

CATV.CATScript file (for example "C:\CGTech61\Windows\CATV5").  
7. "Close" the "Macro Libraries" dialog.  
8. "Close" the "Macros" dialog.  
9. Pick "Tools" > "Customize ..." from CATIA's menus.  
10. In the "Customize" dialog, bring the "Commands" tab to the front.  
11. Select "Macros" from the left-hand list of "Categories".  
12. Pick "CATV.CATScript" from the right-hand list of "Commands".  
13. Click on the "Show Properties ..." button.  
14. Pick the "..." button to the right of the "Icon:" label.  
15. In the "Icon Browser" dialog you need to step through the pages of icons until you 

find the one for CATV ( ). The icons are presented in alphabetic order of their 
names, which you can see by allowing the mouse cursor to sit over an icon for a 



 

brief period. The CATV icon ( ) will probably be on the twelfth page. Pick it 
and "Close" the "Icon Browser".  

16. Back on the "Customize" dialog, position the mouse cursor over the name of the 
macro, CATV.CATScript, in the right-hand list, depress the left mouse button, 
and drag the cursor to the toolbar where you want the icon to appear. It's counter-
intuitive, but you drag the macro name, not the icon! Repeat this step if you want 
the icon to appear on more than one toolbar.  

17. "Close" the "Customize" dialog.  

 

If errors occur, visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 

You should now be ready to start using the CATIA V5-to-VERICUT Interface. For 
complete details on using the CATIA V5-to-VERICUT Interface, see CATIA V5-to-
VERICUT Interface, in the CAD/CAM Interfaces section of Converters and 
CAD/CAM Interfaces, located in the CGTech Help Library. 

 
Return to Installation Steps. 

http://cgtech.com/forum/
http://cgtech.com/


 

 

Configuring the Edgecam-to-VERICUT Interface 
 
 
Choose the version you want to configure: 

Edgecam-to-VERICUT Interface (Edgecam 10) – See below. 

Edgecam-to-VERICUT Interface (Edgecam 11, 11.5 & 12) 

Edgecam-to-VERICUT Interface (Edgecam 12.5, 2000 R1 &2009 R2) 
 

Configuring the Edgecam-to-VERICUT Interface 
(Edgecam 10) 
Six files are required by the VERICUT interface in an existing Edgecam 10.0 system. 
Four of these files are language dependent and must be copied from the appropriate 
English, French, or German folder. The distributed files are: 

 

VericutPDI.exe 

VericutSetPDI.exe 

VericutPDI.dfn    (language dependent) 

VericutPDI.pdi  (language dependent) 

VericutSetPDI.pdi  (language dependent) 

VericutPDI.lan    (language dependent) 

 

These files are located in the \cgtechxx\windows\edgecam\  or 
\cgtechxx\windows64\edgecam\  folder of your VERICUT installation. The xx represents 
the VERICUT version number. For VERICUT 7.0 the xx would be 70. 

 

Assuming EdgeCAM is installed at C:\Program Files\Edgecam , move the following files 
to the EdgeCAM folders indicated. 

 

C: \Program Files\Edgecam\Cam\pdi\Menu-Run\VericutPDI.exe   (Vericut interface 
PDI executable) 

C: \Program Files\Edgecam\Cam\pdi\Menu-Run\ VericutSetPDI.exe   (Reset PDI 
executable) 



 

C: \Program Files\Edgecam\Cam\pdi\src\VericutPDI.pdi   (Vericut interface dialog 
definition) 

C: \Program Files\Edgecam\Cam\pdi\src\ VericutSetPDI.pdi   (Vericut Reset dialog 
definition) 

C:\Program Files\Edgecam\Language\VericutPDI.dfn      (Drop down menu 
definition) 

C: \Program Files\Edgecam\Language\VericutPDI.lan – Language specific file  

 

Edgecam checks file dates of "dfn" and "pdi" each time it executes and updates the 
master menu file when new files are detected. The file date for the VericutPDI.dfn, 
VericutPDI.pdi, and VericutSetPDI.pdi files must be newer than the last time Edgecam 
updated its master menu file. After moving the above files to their proper locations, use a 
text editor to force the VericutPDI.dfn, VericutPDI.pdi, and VericutSetPDI.pdi file dates 
to a current value. You only need to do this once before starting Edgecam. 

The folder path where VERICUT is installed must be defined in an environment variable 
for the Edgecam interface PDI to spawn the VERICUT process. 

For example 

CGTECH_INSTALL=C:\cgtechxx\ 

Where xx is the VERICUT release number. For VERICUT 7.0 the environment variable 
would be set to CGTECH_INSTALL=C:\cgtech70\. 

 

The following is included to enable you to create a .bat file that, when executed, copies 
the necessary VERICUT-to-EdgecamInterface files from the VERICUT installation to 
the correct Edgecam locations and renames the Edgekrnl.mnu to be Edgekrnl.old thus 
forcing Edgecam to recompile its menus. 

 

Creating the Edgecam_Inst.bat file: 
1. Copy the lines shown below to a text file. 

2. Edit the file locations in the top of the .bat file as necessary 

3. Save the text file as Edgecam_Inst.bat 

4. Copy the Edgecam_Inst.bat file to the VERICUT \commands\ directory 

 

 

@echo on 
 
rem Following line references the installation folder for VERICUT, change as 
required. 



 

set CGTECH_INSTALL=C:\cgtech70 
 
rem Where EdgeCAM is installed, change as required 
set EDGECAM_INSTALL="C:\Program Files\EdgeCAMV10" 
 
Copy %CGTECH_INSTALL%\windows\edgecam\*.exe 
%EDGECAM_INSTALL%\Cam\PDI\Menu-Run 
 
Copy %CGTECH_INSTALL%\windows\edgecam\English\vericutpdi.lan 
%EDGECAM_INSTALL%\Language 
 
Copy %CGTECH_INSTALL%\windows\edgecam\English\VericutPDI.dfn 
%EDGECAM_INSTALL%\Language 
 
Copy %CGTECH_INSTALL%\windows\edgecam\English\VericutPDI.pdi 
%EDGECAM_INSTALL%\Cam\PDI\Src 
 
Copy %CGTECH_INSTALL%\windows\edgecam\English\VericutPDI.dfn 
%EDGECAM_INSTALL%\Cam\PDI\Src 
 
Rem Next line forces EdgeCAM to rebuild its menu file 
Ren %EDGECAM_INSTALL%\Language\EdgeKrnl.mnu EdgeKrnl.old 
 
pause 

 

If errors occur, visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 

You should now be ready to start using the Edgecam-to-VERICUT Interface. For 
complete details on using the Edgecam-to-VERICUT Interface, see Edgecam-to-
VERICUT Interface, in the CAD/CAM Interfaces section of Converters and 
CAD/CAM Interfaces, located in the CGTech Help Library. 

 

 

Return to Installation Steps. 

http://cgtech.com/forum/
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Configuring the Edgecam-to-VERICUT Interface 
(Edgecam 11, 11.5 & 12) 
Seven files are required for the VERICUT interface in an existing Edgecam system. Four 
of these files are language dependent and must be copied from the appropriate English, 
French, or German folder. The distributed files are: 

 

VericutPDI.exe 

VericutSetPDI.exe 

VericutPDI.dfn    (language dependent) 

VericutPDI.pdi  (language dependent) 

VericutSetPDI.pdi  (language dependent) 

VericutPDI.lan    (language dependent) 

Vericut.commands  

 

These files are located in the \cgtechxx\windows\edgecam\ or 
\cgtechxx\windows64\edgecam\ folder of your VERICUT installation. The xx represents 
the VERICUT version number. For VERICUT 7.0 the xx would be 70. 

 

Assuming Edgecam is installed at C:\Program Files\Edgecam, move the following files to 
the Edgecam folders indicated. 

 

C: \Program Files\Edgecam\Cam\pdi\Menu-Run\VericutPDI.exe   (Vericut interface 
PDI executable) 

C: \Program Files\Edgecam\Cam\pdi\Menu-Run\ VericutSetPDI.exe   (Reset PDI 
executable) 

C: \Program Files\Edgecam\Cam\pdi\src\VericutPDI.pdi   (Vericut interface dialog 
definition) 

C: \Program Files\Edgecam\Cam\pdi\src\ VericutSetPDI.pdi   (Vericut Reset dialog 
definition) 

C: \Program Files\Edgecam\Cam\Support\ Vericut.commands 

C:\Program Files\Edgecam\Language\VericutPDI.dfn      (Drop down menu 
definition) 

C: \Program Files\Edgecam\Language\VericutPDI.lan – Language specific file  

 



 

Edgecam checks file dates of "dfn" and "pdi" each time it executes and updates the 
master menu file when new files are detected. The file date for the VericutPDI.dfn, 
VericutPDI.pdi, and VericutSetPDI.pdi files must be newer than the last time EdgeCAM 
updated its master menu file. After moving the above files to their proper locations, use a 
text editor to force the VericutPDI.dfn, VericutPDI.pdi, and VericutSetPDI.pdi file dates 
to a current value. You only need to do this once before starting EdgeCAM. 

 

The folder path where VERICUT is installed must be defined in an environment variable 
for the Edgecam interface PDI to spawn the VERICUT process. For example: 

 

CGTECH_INSTALL=C:\cgtechxx\ 

 

Where xx is the VERICUT release number. For VERICUT 7.0 the environment variable 
would be set to CGTECH_INSTALL=C:\cgtech70\. 

 

The following is included to enable you to create a .bat file that, when executed, copies 
the necessary VERICUT-to-Edgecam Interface files from the VERICUT installation to 
the correct Edgecam locations and renames the Edgekrnl.mnu to be Edgekrnl.old thus 
forcing Edgecam to recompile its menus. 

 

Creating the Edgecam_Inst.bat file: 
1. Copy the lines shown below to a text file. 

2. Edit the file locations in the top of the .bat file as necessary 

3. Save the text file as Edgecam_Inst.bat 

4. Copy the Edgecam_Inst.bat file to the VERICUT \commands\ directory 

 

The lines shown below need to be copied to the Edgecam_Inst.bat file (watch line wrap): 

 

@echo on 
 
rem Following line references installation folder for VERICUT 
 
set CGTECH_INSTALL=C:cgtech70 
 
rem Where EdgeCAM is installed 
 



 

set EDGECAM_INSTALL="C:Program FilesEdgeCAM" 
 
Copy %CGTECH_INSTALL%windowsedgecam*.exe 
%EDGECAM_INSTALL%CamPDIMenu-Run 
 
Copy %CGTECH_INSTALL%windowsedgecamEnglishvericutpdi.lan 
%EDGECAM_INSTALL%Language 
 
Copy %CGTECH_INSTALL%windowsedgecamEnglishVericutPDI.dfn 
%EDGECAM_INSTALL%Language 
 
Copy %CGTECH_INSTALL%windowsedgecamEnglishVericutPDI.pdi 
%EDGECAM_INSTALL%CamPDISrc 
 
Copy %CGTECH_INSTALL%windowsedgecamEnglishVericutPDI.dfn 
%EDGECAM_INSTALL%CamPDISrc 
 
Ren %EDGECAM_INSTALL%LanguageEdgeKrnl.mnu EdgeKrnl.old 
 
pause 

 

If errors occur, visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 

You should now be ready to start using the Edgecam-to-VERICUT Interface. For 
complete details on using the Edgecam-to-VERICUT Interface, see Edgecam-to-
VERICUT Interface, in the CAD/CAM Interfaces section of Converters and 
CAD/CAM Interfaces, located in the CGTech Help Library. 

 

 

Return to Installation Steps. 
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Configuring the Edgecam-to-VERICUT Interface 
(Edgecam 12.5, 2009 R1 & 2009 R2) 
 

Five files are required for the VERICUT interface in an existing Edgecam system. Four 
of these files are language dependent and must be copied from the appropriate English, 
French, or German folder.  

The distributed files are: 

VericutPDI.exe 

VericutPDI.dfn      (language dependent) 

VericutPDI.pdi  (language dependent) 

VericutPDI.lan      (language dependent) 

Vericut.commands  

 

These files are located in the \cgtechxx\windows\edgecam\ or 
\cgtechxx\windows64\edgecam\ folder of your VERICUT installation. The xx represents 
the VERICUT version number. For VERICUT 7.0 the xx would be 70. 

 

Assuming Edgecam is installed at C:\Program Files\Edgecam, copy the following files to 
the Edgecam folders indicated. 

 

C: \Program Files\Edgecam\Cam\pdi\Menu-Run\VericutPDI.exe   (Vericut interface 
PDI executable) 

C: \Program Files\Edgecam\Cam\pdi\src\VericutPDI.pdi   (Vericut interface dialog 
definition) 

C: \Program Files\Edgecam\Cam\Support\ Vericut.commands 

C:\Program Files\Edgecam\Language\VericutPDI.dfn      (Drop down menu 
definition) 

C: \Program Files\Edgecam\Language\VericutPDI.lan – Language specific file  

 

Edgecam checks file dates of "dfn" and "pdi" each time it executes and updates the 
master menu file when new files are detected. The file date for the VericutPDI.dfn and 
VericutPDI.pdi files must be newer than the last time Edgecam updated its master menu 
file. After moving the above files to their proper locations, use a text editor to force the 
VericutPDI.dfn, VericutPDI.pdi, and VericutSetPDI.pdi file dates to a current value. You 
only need to do this once before starting Edgecam. 



 

 

To enable the Edgecam interface PDI to spawn the VERICUT process, you also need to 
define three environment variables, CGTECH_INSTALL, CGTECH_PRODUCTS 
and LSHOST. 

For example; 

  

Environment Variable 
Name Variable Value 

CGTECH_INSTALL C:\cgtechxx 

CGTECH_PRODUCTS 

C:\cgtechxx\windows 

or 

C:\cgtechxx\windows64 

LSHOST  server_name 

 

CGTECH_INSTALL is set to the top level folder where VERICUT is installed. In the 
above table, xx represents the VERICUT release number. For VERICUT 7.0 the 
environment variable would be set to C:\cgtech70.  

CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: either "windows" or "windows64". For a typical 
VERICUT 7.0 installation this variable is set to C:\cgtech70\windows or 
C:\cgtech70\windows64. 

LSHOST is set to the name of the license server computer. 

Use the Microsoft Windows Control Panel > System Properties: Advanced tab, 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information. 

 

To add an Edgecam-to-VERICUT menu option to the Edgecam main menu bar, complete 
the following: 

1. Start Edgecam 

2. Open an Edgecam part with an existing machining sequence. 

3. In the Edgecam main menu bar select Options > Manufacture, or click on the 
 (Switch to Manufacture Mode) icon to switch to manufacturing mode. 

 

 



 

4. Once in Manufacturing mode, right click on the menu bar and choose Customise 
from the pull-down list. 

 
 
 

 
 
 
 

5. Select the Transfer tab and click on the Menu option, Load button. 
 
 

 
 



 

The following window should display. 
 

 
 
 

6. Select Vericut.commands, then Open. The Vericut menu and pull-down option 
list should now be added to the Edgecam main menu bar as shown below. 

 
 

 
 
 

If errors occur, visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 

You should now be ready to start using the Edgecam-to-VERICUT Interface. For 
complete details on using the Edgecam-to-VERICUT Interface, see Edgecam-to-
VERICUT Interface, in the CAD/CAM Interfaces section of Converters and 
CAD/CAM Interfaces, located in the CGTech Help Library. 

http://cgtech.com/forum/
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Return to Installation Steps. 



 

 

Configuring the GibbsCam-to-VERICUT Interface 
(GibbsV) 
 
The GibbsCam-to-VERICUT Interface is distributed as two files; 
 

GibbsV.dll (the code) 
Gibbsv[language].local (localization file) 

 
Supported localization files: 

GibbsvEnglish.local 
GibbsvFrench.local 
GibbsvSpanish.local 
GibbsvJapanese.local 
GibbsvChinese.local 
GibbsvKorean.local 
GibbsvItalian.local 
GibbsvGerman.local 
GibbsvSwedish.local 
 

These files are located in the \cgtechxx\windows\GibbsV\  or 
\cgtechxx\windows64\GibbsV\  folder of your VERICUT installation. xx represents the 
VERICUT version number. For VERICUT 7.0 the xx would be 70. 
 

The GibbsV.dll file should be placed in the GibbsCAM plugins directory (for example, 
C:\Program Files\Gibbs\GibbsCAM\8.0.19_NLO\plugins\. 

The localization file should be left in the \GibbsV\ directory of your VERICUT 
installation directory. 

 
The GibbsCAM-to-VERICUT Interface must have the following  two environment 
variables set before using. 
 

Environment Variable 
Name Variable Value 

CGTECH_PRODUCTS C:\cgtechxx\windows 

or 

C:\cgtechxx\windows64 

LSHOST  server_name 

 



 

CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: either "windows" or "windows64". For a typical 
VERICUT 7.0 installation this variable is set to C:\cgtech70\windows or 
C:\cgtech70\windows64. 

LSHOST is set to the name of the license server computer. 

Use the Microsoft Windows Control Panel > System Properties: Advanced tab, 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information. 

 
Accessing the GibbsCAM to VERICUT Interface 
To start the GibbsCAM to VERICUT Interface from within GibbsCAM, click Plug-Ins 
in the GibbsCam main menu, then select VERICUT from the pull-down list. 

 

If errors occur, visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 

You should now be ready to start using the GibbsCAM-to-VERICUT Interface. For 
complete details on using the GibbsCAM-to-VERICUT Interface, see GibbsCAM-to-
VERICUT Interface (GibbsV), in the CAD/CAM Interfaces section of Converters and 
CAD/CAM Interfaces, located in the CGTech Help Library. 

 

Return to Installation Steps. 
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Configuring the Mastercam-to-VERICUT Interface 
 
 
Choose the version you want to configure: 

Mastercam-to-VERICUT Interface (MCAMV - Versions 8 & 9) – See below. 

Mastercam-to-VERICUT Interface (MCAMV - Version X) 

Mastercam-to-VERICUT Interface (MCAMV - Version X2) 
 

Configuring the Mastercam-to-VERICUT Interface 
(MCAMV - Versions 8 & 9) 
  

Using Mastercam's terminology, the interface between Mastercam and VERICUT is a C-
Hook. It can be invoked while running Mastercam, transfers internal Mastercam data to 
files recognized by VERICUT, and fires up VERICUT ready to perform verification of 
the toolpaths. You can opt to verify Mastercam's Intermediate NC data (NCI) or the G-
code files produced by Mastercam's post-processors.  

 

Configuration 
The VERICUT C-Hook is for Mastercam V8, or Mastercam V9. For Mastercam V8 it is 
distributed as three files located in the C:\cgtechxx\windows\mcamv\V8\ or 
C:\cgtechxx\windows64\mcamv\V8\ directory of your VERICUT installation. 

For Mastercam V9 it is distributed as three files located in the 
C:\cgtechxx\windows\mcamv\V9\ or C:\cgtechxx\windows64\mcamv\V9\ directory of 
your VERICUT installation. 

In either case, the xx represents the VERICUT release number. For VERICUT 7.0 the xx 
would be 70. 

 

VERICUT.dll   (the code)   

VERICUT.txt   (message text)   

VERICUT.scr   (dialog script) 

 

The text and script files can be localized where desired. All three files should be placed in 
Mastercam's "chooks" folder, which is one level down from the Mastercam installation 
folder (for example C:\Mcam9\chooks).  



 

  

Preparation 
Mastercam V8 does not carry as much information about units in a ".MC8" file as version 
9 does in its ".MC9" files. Before using the VERICUT C-Hook with a Mastercam V8 
file, you need to ensure that it will be able interpret the units correctly. Having retrieved a 
".MC8" file with "File > Get", use "Screen > Configure" to bring up the "System 
Configuration" dialog. In the low-left corner you will see a choice box labeled "Current 
Configuration File" and each choice has "(English)" or "(Metric)" after the file name. 
You need to ensure that the selected file has the same units as the job's stock. For 
example, if you are using "Mill 9", you could select "Mill9.cfg (English)" or "Mill9M.cfg 
(Metric)" depending on whether the job's units are inches or millimeters. 

 

Access 
Start Mastercam using one of the mastercamx.bat files located in the "commands" folder 
of your VERICUT installation. Included are .bat files for the Mastercam MILL8 and 
MILL9 modules. To access VERICUT from another Mastercam module, for example 
LATHE, create a separate .bat file (using the included .bat files as an example) for each 
additional Mastercam module that you want to access VERICUT from. 

 

NOTE:  If you choose to use the "standard" Mastercam icon to start Mastercam, instead 
of using one of the mastercamx.bat  files provided, you also need to define the following 
environment variables, CGTECH_PRODUCTS and LSHOST,  to enable the C-Hook 
to find VERICUT. 

For example; 

 Environment 
Variable Name Variable Value 

CGTECH_PRODUCTS 

C:\cgtechxx\windows 

or 

C:\cgtechxx\windows64 

LSHOST  server_name 

 

The CGTECH_PRODUCTS environment variable is set to specify where CGTech 
products have been installed. In the above table, xx represents the VERICUT release 
number. For VERICUT 7.0 the environment variable would be set to 
CGTECH_PRODUCTS=C:\cgtech70\windows or 
CGTECH_PRODUCTS=C:\cgtech70\windows64. 

The LSHOST environment variable is set to the name of the license server computer. 



 

To trigger the C-Hook while in Mastercam, hold down the Alt key and click the C key 
(referred to as Alt-C). You will see a file selection dialog offering all the installed C-
Hooks. Pick VERICUT.dll and click on the Open button.  

Alternatively, you can add a reference to the C-Hook in Mastercam's menu structure, 
either in an empty space, or by replacing a choice that you are unlikely to exercise. 
Mastercam's documentation covers this process, but you would potentially need to edit 
three files (mill9.txt, lathe9.txt and wire9.txt) if you intend to trigger VERICUT from all 
three Mastercam applications. These files are located in Mastercam's installation folder 
(for example C:\Mcam9).  

To place a C-Hook in an empty menu location, between the double quotes enter the name 
of the C-Hook, followed by an asterisk. So for this C-Hook it could read "VERICUT*". 
Keep in mind that a menu cannot have more than ten choices. If you wish to use a key-
stroke to pick a menu item, you can precede the trigger letter with an ampersand, after 
first checking that no other item in the menu uses the same letter. So if V is available, you 
could enter "&VERICUT*".  

 

If errors occur, visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 
You should now be ready to start using the Mastercam-to-VERICUT Interface. For 
complete details on using the Mastercam-to-VERICUT Interface, see Accessing and 
Using the Mastercam-to-VERICUT Interface (MCAMV), in the CAD/CAM 
Interfaces section of Converters and CAD/CAM Interfaces, located in the CGTech Help 
Library. 
 

Return to Installation Steps. 
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Configuring the Mastercam-to-VERICUT Interface 
(MCAMV - Version X) 
  

Using Mastercam's terminology, the interface between MastercamX and VERICUT is a 
Net-Hook. It can be invoked while running Mastercam, transfers internal Mastercam data 
to files recognized by VERICUT, and fires up VERICUT ready to perform verification of 
the toolpaths. You can opt to verify Mastercam's Intermediate NC data (NCI) or the G-
code files produced by Mastercam's post-processors. 

 

Configuration 
The VERICUT C-Hook is for Mastercam X. It is distributed as four files located in the 
C:\cgtechxx\windows\mcamv\X\ , or the C:\cgtechxx\windows64\mcamv\X\, directory of 
your VERICUT installation. The xx represents the VERICUT release number. For 
VERICUT 7.0 the xx would be 70. 

 

VERICUT.dll   (the code) 

VericutSupport.dll   (supporting code) 

mcRes.local   (language translation) 

VERICUT.ft   (used to map an Icon into the Mastercam menu interface) 

 

The two .dll files and the .ft file should be placed in Mastercam's "chooks" folder, which 
is one level down from the Mastercam installation folder (for example 
C:\McamX\chooks). The file mcRes.local should be placed in the Mastercam installation 
folder. 

 

To enable the C-Hook to find VERICUT, you also need to define two environment 
variables, CGTECH_PRODUCTS and LSHOST. 



 

For example; 

  

Environment Variable 
Name Variable Value 

CGTECH_PRODUCTS 

C:\cgtechxx\windows 

or 

C:\cgtechxx\windows64 

LSHOST  server_name 

 

The CGTECH_PRODUCTS environment variable is set to specify where CGTech 
products have been installed. In the above table, xx represents the VERICUT release 
number. For VERICUT 7.0 the environment variable would be set to 
CGTECH_PRODUCTS=C:\cgtech70\windows or 
CGTECH_PRODUCTS=C:\cgtech70\windows64. 

The LSHOST environment variable is set to the name of the license server computer. 

Use the Microsoft Windows Control Panel > System Properties: Advanced tab, 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information. 

 

Access 

To trigger the Net-Hook while in Mastercam, hold down the Alt key and click the C key 
(referred to as Alt-C).  Alternatively, you could select Settings > Run User Application. 
You will see a file selection dialog offering all the installed C-Hooks. Pick 
VERICUT.dll and click on the Open button. 

 

Setting up a VERICUT icon in Mastercam X user interface 
 

 
 
In Mastercam main window, select Settings > Customize  

 



 

1. In Customize window, change Category to NET Hook  
2. Select the VERICUT icon in the "Commands" area, and drag and drop it onto the 

toolbar in the Mastercam main window  
3. In the Customize window, in the Toolbars list, right click on "New Toolbar" and 

select Rename Toolbar, rename it to something like Run VERICUT, then Enter.  
4. Select the Diskette (Save As) icon, save as filename.mtb , OK  
5. Click on the checkmark (OK) button to close the Customize window. 

 

In Mastercam main window, select Settings > Configuration 

1. In the System Configuration window, under Topics, select Start / Exit. 

2. Under Startup Settings, point Toolbars to the filename.mtb file that you created 
above. Either enter the /path/filename in the text field or click on the File Cabinet 
icon (Select) and use the window that displays to select the file. 

3. Click on the checkmark (OK) button to close the System Configuration window. 

4. If prompted: "Save Settings to Configuration File?", Yes. 

See Mastercam Help for additional information. 

 

If errors occur, visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 
You should now be ready to start using the Mastercam-to-VERICUT Interface. For 
complete details on using the Mastercam-to-VERICUT Interface, see Mastercam-to-
VERICUT Interface (MCAMV), in the CAD/CAM Interfaces section of Converters 
and CAD/CAM Interfaces, located in the CGTech Help Library. 
 

Return to Installation Steps. 
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Configuring the Mastercam-to-VERICUT Interface 
(MCAMV - Version X2 and X3) 
  

Using Mastercam's terminology, the interface between MastercamX2 and VERICUT is a 
Net-Hook. It can be invoked while running Mastercam, transfers internal Mastercam data 
to files recognized by VERICUT, and fires up VERICUT ready to perform verification of 
the toolpaths. You can opt to verify Mastercam's Intermediate NC data (NCI) or the G-
code files produced by Mastercam's post-processors. 

 

NOTE:  MCAMV –Version X2 requires the installation of the Microsoft C++ run time 
environment. This is not distributed automatically by Microsoft. A copy of the installer is 
on the VERICUT CD, or at: 

ftp://ftp.cgtech.com/Download/pointrel/windows/vcredist_x86_mcamx2.exe 

Administrator privileges are required to install this.  

You do not need this if you have Microsoft Visual Studio C++ 2005 installed (not likely 
for most VERICUT users).  

 

Configuration 
The VERICUT C-Hook is for Mastercam X2. It is distributed as four files located in the 
C:\cgtechxx\windows\mcamv\X2\ or C:\cgtechxx\windows64\mcamv\X2\ directory of 
your VERICUT installation. The xx represents the VERICUT release number. For 
VERICUT 7.0 the xx would be 70. 

 

VERICUT.dll   (the code) 

VericutSupport.dll   (supporting code) 

mcRes.local   (language translation) 

VERICUT.ft   (used to map an Icon into the Mastercam menu interface) 

 

 The two .dll files and the .ft file should be placed in Mastercam's "chooks" folder, which 
is one level down from the Mastercam installation folder (for example 
C:\McamX\chooks). The file mcRes.local should be placed in the Mastercam installation 
folder. 

To enable the C-Hook to find VERICUT, you also need to define three environment 
variables, CGTECH_INSTALL, CGTECH_PRODUCTS and LSHOST. 

ftp://ftp.cgtech.com/Download/pointrel/windows/vcredist_x86_mcamx2.exe


 

For example; 

  

Environment Variable 
Name Variable Value 

CGTECH_INSTALL C:\cgtechxx 

CGTECH_PRODUCTS 

C:\cgtechxx\windows 

or 

C:\cgtechxx\windows64 

LSHOST  server_name 

 

CGTECH_INSTALL is set to the top level folder where VERICUT is installed. In the 
above table, xx represents the VERICUT release number. For VERICUT 7.0 the 
environment variable would be set to C:\cgtech70.  

CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: either "windows" or "windows64". For a typical 
VERICUT 7.0 installation this variable is set to C:\cgtech70\windows or 
C:\cgtech70\windows64. 

LSHOST is set to the name of the license server computer. 

Use the Microsoft Windows Control Panel > System Properties: Advanced tab, 
Environment Variables feature to define these environment variables. See Microsoft 
Windows Help for more information. 

 
Access 

To trigger the Net-Hook while in Mastercam, hold down the Alt key and click the C key 
(referred to as Alt-C).  Alternatively, you could select Settings > Run User Application. 
You will see a file selection dialog offering all the installed C-Hooks. Pick 
VERICUT.dll and click on the Open button. 

 



 

 

Setting up a VERICUT icon in MasterCam X2 and X3 user interface 
 

 
 
In Mastercam main window, select Settings > Customize  

1. In Customize window, change Category to NET Hook  
2. Select the VERICUT icon in the "Commands" area, and drag and drop it onto the 

toolbar in the Mastercam main window  
3. In the Customize window, in the Toolbars list, right click on "New Toolbar" and 

select Rename Toolbar, rename it to something like Run VERICUT, then Enter.  
4. Select the Diskette (Save As) icon, save as filename.mtb , OK  
5. Click on the checkmark (OK) button to close the Customize window. 

 

In Mastercam main window, select Settings > Configuration 

1. In the System Configuration window, under Topics, select Start / Exit. 

2. Under Startup Settings, point Toolbars to the filename.mtb file that you created 
above. Either enter the /path/filename in the text field or click on the File Cabinet 
icon (Select) and use the window that displays to select the file. 

3. Click on the checkmark (OK) button to close the System Configuration window. 

4. If prompted: "Save Settings to Configuration File?", Yes. 

See Mastercam Help for additional information. 

 

If errors occur, visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 
You should now be ready to start using the Mastercam-to-VERICUT Interface. For 
complete details on using the Mastercam-to-VERICUT Interface, see Mastercam-to-
VERICUT Interface (MCAMV), in the CAD/CAM Interfaces section of Converters 
and CAD/CAM Interfaces, located in the CGTech Help Library. 
 

Return to Installation Steps. 
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Configuring the NX-to-VERICUT Interface (NXV) 
 

This section documents supported versions of NX, and the procedure for configuring the 
NX-to-VERICUT Interface (NXV). These instructions apply only when VERICUT will 
be run via NXV. If VERICUT will only be run outside of NX, then ignore this section. 

 

NX version support 
NXV can be operated on UNIX and Windows computers with NX versions NX2, NX3, 
NX4, NX5 and NX6. 

VERICUT Interfaces for old Unigraphics versions (V16, V17, V18, NX,) are no longer 
distributed with the VERICUT installation. You can copy the old interface files forward 
from a previous installation, or contact VERICUT technical support for the older 
Unigraphics interface files. 

Upward compatibility of the old interfaces is not tested with this release and not 
guaranteed. However nothing is intentionally changed to prevent them from continuing to 
work. 

 

Configuration 
Follow the general procedure below to configure NXV. Integrating NXV into your 
standard UG startup may require "root" or administrator permissions - see your system 
administrator for assistance. 

NOTE:  The following NX products, ufunc_execute (P2_ufunc_execute for NX2, 
product name "UG/Open API Execute") and the grip_execute (product name "UG/Open 
Grip Execute") are required for NXV. 

Assuming NX is installed, install VERICUT (includes the NXV software) per the 
VERICUT installation instructions. 

Windows 

1. Locate the NXV batch file for your version of NX 
Look in VERICUT’s 'commands' folder (C:\cgtechxx\platform\commands\ 
directory of your VERICUT installation. The xx represents the VERICUT release 
number. For VERICUT 7.0 the xx would be 70. The platform represents windows, 
or windows64) for the batch file named ugv_nxV.bat (where V represents the NX 
version, i.e. ugv_nx2.bat, ugv_nx3.bat, etc). The batch file sets the environment 
for NXV, then runs NX using %UGII_ROOT_DIR%\UGII.BAT. 



 

NOTE:   If you need a batch file for a newer/higher version of NX use the 
highest nxV.bat available in the folder. The interfaces are usually upward 
compatible with newer versions of NX. 

 

2. Create a desktop shortcut to the batch file 
Create a desktop shortcut that points to the NXV batch file found in step 1. Set the 
shortcut's start-in property to a folder where the user has write permission.  

You can optionally copy the batch file to a folder where you have write 
permission and run it directly from there. 

 

NOTE:  The NXV batch file will NOT work correctly from its location in the 
VERICUT’s ‘commands’ folder because users usually do not have write 
permissions there. You must either create a desktop shortcut with a start-in path 
where you have write permissions, or copy the batch file to a directory where you 
have permission to write files. 

 

NOTE FOR NX SYSTEM ADMINISTRATORS:  To integrate the 
NXV interface into your normal NX startup process, copy the environment 
settings from NXxx.bat into your normal NX startup process. Do not copy the 
line that runs NX. 

UNIX 

1. Locate the NXV run script for your version of NX 
Look in VERICUT’s 'commands' directory (/cgtechxx/\platform/commands/ 
directory of your VERICUT installation. The xx represents the VERICUT release 
number. For VERICUT 7.0 the xx would be 70. The platform represents solaris, 
rs, or hp) for a file named ugv_nxV.bat (where V represents the NX version, i.e. 
ugv_nx2.bat, ugv_nx3.bat, etc). The script sets the environment for NXV then 
runs NX using the command ‘ugii’. 

NOTE:   If you need a script for  a newer/higher version of NX use the highest 
nxXX script available in the directory. The interfaces are usually upward 
compatible with newer versions of NX. 

2. Copy the nxXX script found in step 1 to a directory where the user has write 
permission.  

 

NOTE:  The NXV script will NOT work correctly from its location in the 
VERICUT’s 'commands' directory because users usually do not have write 
permissions there. You must copy the script to a directory where the user has 
permission to write files. 

 



 

NOTE FOR NX SYSTEM ADMINISTRATORS:  To integrate the 
NXV interface into your normal NX startup process, copy the environment 
settings from the nxXX script into your normal NX startup process. Do not copy 
the line that runs NX. 

 

Start NX with NXV. 
After completing the previous steps and assuming VERICUT is licensed and operational, 
run NX using the batch file short cut (or UNIX script). If NX does not start, DO NOT 
CONTINUE - see your system administrator for assistance. 

Depending on the version of NX, NXV is accessed differently. See the help on using 
NXV in the Converters and CAD/CAM Interfaces section, in the CGTech Help Library, 
for details. 

 

Configuring NXV to start VERICUT with a custom Project file 
If no Project Template is specified in the NXV interface dialog, NXV initializes 
VERICUT with the following project from VERICUT’s Library folder: 

• ug_init.VcProject (inch NX session) 

• ug_initm.VcProject (millimeter NX session)  

The interface adds models, NX program(s), and tools from the current session, then runs 
VERICUT.  

You can change VERICUT’s default settings by modifying ug_init.Vc Project (or 
ug_initm.VcProject). We recommend you save a backup copy of these files before 
modifying them. The files are located in the "library" folder in your VERICUT 
installation. 

 

If errors occur, visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 
You should now be ready to start using the NX-to-VERICUT Interface. For complete 
details on using the NX-to-VERICUT Interface, see NX-to-VERICUT Interface 
(NXV), in the CAD/CAM Interfaces section of Converters and CAD/CAM Interfaces, 
located in the CGTech Help Library. 
 

Return to Installation Steps. 
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Setting up NXV to work with Teamcenter 
Overview 
Teamcenter (formerly IMAN and UG Manager) is a Product Lifecycle Management 
(PLM) application that manages NX data files. When using the NX-to-VERICUT 
Interface (NXV), it is necessary to modify the NX Teamcenter environment in order for 
NXV to operate correctly. 

NXV uses Teamcenter functions for reading data and writing files when running within 
Teamcenter. For example:  

• If Teamcenter is not used, NXV asks NX to write VERICUT model files to the 
path specified in the NXV interface.  

• If Teamcenter is used, NXV asks Teamcenter to ask NX to write model files. 
Teamcenter then places the files in a "temporary" Teamcenter folder.  

NXV detects when it is running within Teamcenter and uses Teamcenter data 
management functions when requesting and writing data.  

All VERICUT files for the current session are placed by Teamcenter in the "temporary" 
Teamcenter folder for the current checked-out project. At the end of the NX session, 
Teamcenter prompts the user to check the files in.  

VERICUT files are considered, "meta-data" by Teamcenter. "meta data" is data with 
unknown content, but the files are controlled by Teamcenter. 

 

Implementing NXV in a Teamcenter installation  
NOTE:  The following example shows modifying a Teamcenter windows batch file for 
NX2 on Windows, but the concept is the same for later NX versions, or when using a perl 
or UNIX script to start Teamcenter. 

The Teamcenter startup batch file (in this example, START_UGMANAGER.BAT) sets 
the environment for starting NX2 with Teamcenter on Windows. The Teamcenter  startup 
batch file must be modified to call the modified NXV batch file (NX2.bat, NX3.bat, etc, 
depending on your version of NX) from VERICUT’s commands folder.  

1. Modify 2 lines in NXV’s startup batch file. 

Add rem at the beginning of the following lines in the NX2.bat file. 

rem set CGTECH_INSTALL=C:\cgtech70 
rem "%UGII_ROOT_DIR%\UGII.BAT"  %argstr% 

See the highlighted text in the example modified NX2.bat file below. 

2. Call the NXV batch file (as modified in step 1) from the Teamcenter startup 
script. The call must be inserted above the command that launches NX. Calling 



 

the NXV batch file sets the environment for NXV and VERICUT from the 
Teamcenter startup script. This edit is usually done by the Teamcenter site 
administrator.  

Example lines to add to a Teamcenter startup batch file that uses Windows batch 
file syntax: 

set CGTECH_INSTALL=C:\cgtech70 
call "%CGTECH_INSTALL%\windows\commands\NX2"  

NOTE:  The above example is for a Windows batch file. The syntax is different 
for a perl or UNIX Teamcenter startup script, however the concept is the same. 

 

3. The Teamcenter site administrator needs to configure Teamcenter to recognize 
VERICUT files as "meta-data". An entry must be made for each extension 
(.VcProject .mch, .ctl, .tls, .opti, .swp, .sor, .vct, etc?) These files will be managed 
by Teamcenter. 

NOTE:  Two temporary files are created by NXV, but do not need to be 
managed by Teamcenter. They have extension .opts and .vctemp. 

 

Sample edited nx2.bat file 
(the two edited lines are highlighted red) 

 
@echo off 
rem set CGTECH_INSTALL=C:\cgtech612 
 
rem          CGTech, Copyright, All Rights Reserved 
 
rem CGTech environment 
call "%CGTECH_INSTALL%\windows\commands\cgtenv"  
 
rem set CGTECH_IGNORELAST=TRUE 
 
set CGTECH_CLASSES=%CGTECH_INSTALL%\classes 
set CGTECH_PRODUCTS=%CGTECH_INSTALL%\windows 
set CGTECH_LIBRARY=%CGTECH_INSTALL%\library\ 
if "%CGTECH_LICENSE%" == "" set 
CGTECH_LICENSE=%CGTECH_PRODUCTS%\license 
if "%TEMP%" == "" set TEMP=C:\TEMP 
if "%TMP%" == "" set TMP=C:\TEMP 
if "%CGTECH_LOCALE%" == "" set CGTECH_LOCALE=english 
set CGTECH_LANGUAGE=%CGTECH_CLASSES%\%CGTECH_LOCALE% 
set CGTECH_HELP=%CGTECH_INSTALL%\hhelp 
set CGTECH_SHOWROOM=%CGTECH_INSTALL%\showroom\ 
set CGTECH_SAMPLES=%CGTECH_INSTALL%\samples\ 
set CGTECH_TRAINING=%CGTECH_INSTALL%\training\ 
set CGTECH_DEFAULT_UNITS=INCH 
set CGTECH_RGB_TXT=%CGTECH_PRODUCTS%\vericut\rgbhues.txt 



 

if "%CGTECH_JRE%" == "" set 
CGTECH_JRE=%CGTECH_PRODUCTS%\jre 
 
 
if NOT "%CGTPATH%" == "" goto cgtpathset 
set 
path=%CGTECH_PRODUCTS%\vericut;%CGTECH_PRODUCTS%\license;
%CATDLLPath%;%PATH% 
set cgtpath=true 
:cgtpathset 
 
set waitopt= 
set argstr= 
if test%1==test goto cgtchkend 
if %1==BATCH set waitopt=/wait 
if %1==batch set waitopt=/wait 
if %1==BATCHP set waitopt=/wait 
if %1==batchp set waitopt=/wait 
set argstr=%1 
shift 
:cgtgetarg 
if test%1==test goto cgtchkend 
if %1==BATCH set waitopt=/wait 
if %1==batch set waitopt=/wait 
if %1==BATCHP set waitopt=/wait 
if %1==batchp set waitopt=/wait 
set argstr=%argstr% %1 
shift 
goto cgtgetarg 
:cgtchkend 
 
if "%OS%" == "Windows_NT" set start_cmd=start "VERICUT" 
%waitopt% 
if "%OS%" == "" set start_cmd=start %waitopt% 
 
set UGII_VENDOR_DIR=%CGTECH_INSTALL%\windows\ugv\v20 
rem "%UGII_ROOT_DIR%\UGII.BAT"  %argstr% 
:end_cgtech 

 

If errors occur, visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 
 
You should now be ready to start using the NX-to-VERICUT Interface. For complete 
details on using the NX-to-VERICUT Interface, see NX-to-VERICUT Interface 
(NXV), in the CAD/CAM Interfaces section of Converters and CAD/CAM Interfaces, 
located in the CGTech Help Library. 
 
 

Return to Installation Steps. 
 

http://cgtech.com/forum/
http://cgtech.com/


 

Starting NXV when starting NX from Start > All 
Programs > NX V.0 > NX V.0 
 

Follow the following steps to enable using the NX-to-VERICUT interface  (NXV) when 
starting NX  from Start > All Programs > Ungraphics NX V.0  > NX V.0, where V.0 is 
the NX version number. 

The CGTech software installation procedure places the files required by NXV in a sub-
folder. If you elected to install the software in the default folder "C:\CGTechxx" (where 
xx is the VERICUT release number), then for VERICUT 7.0, the NXV folder will be 
"C:\cgtech70\windows\nx" or "C:\cgtech70\windows64\nx".  

 

Copy  the files in: 

C:\cgtechxx\windows\nx\v20\application\  or 
C:\cgtechxx\windows64\nx\v20\application\ 

to: 

C:\Program Files\UGS\NX V.0\UGALLIANCE\vendor\application\, 
where V is the NX version number. 

 

Copy  the files in: 

C:\cgtechxx\windows\nx\v20\startup\  or 
C:\cgtechxx\windows64\nx\v20\startup\ 

to: 

C:\Program Files\UGS\NX V.0\UGALLIANCE\vendor\startup\, where 
V.0 is the NX version number. 

 
 
Edit the file: 

C:\Program Files\UGS\NX V.0\UGII\ugii_env.dat 
 

Remove the "#" from variable 
#UGII_VENDOR_DIR=${UGALLIANCE_DIR}vendor 

so that it now looks like 

UGII_VENDOR_DIR=${UGALLIANCE_DIR}vendor 
 



 

To enable NX to find VERICUT, you also need to define two environment variables, 
CGTECH_PRODUCTS and CGTECH_INSTALL. 

For example; 

  

Environment Variable 
Name Variable Value 

CGTECH_INSTALL 

C:\cgtechxx\ 

or 

C:\cgtechxx\ 

CGTECH_PRODUCTS  

C:\cgtechxx\windows\ 

or 

C:\cgtechxx\windows64\ 

 

CGTECH_INSTALL is set to the top level folder where VERICUT is installed. In the 
above table, xx represents the VERICUT release number. For VERICUT 7.0 the 
environment variable would be set to C:\cgtech70.  

CGTECH_PRODUCTS is set to the folder for the specific operating system of the 
computer running VERICUT: either "windows" or "windows64". For a typical 
VERICUT 7.0 installation this variable is set to C:\cgtech70\windows or 
C:\cgtech70\windows64. 

Use the Microsoft Windows Control Panel > System Properties: Advanced tab, 
Environment Variables feature to define these environment variables. See Microsoft  
Windows Help for more information. 



 

 

Configuring the VERICUT TDM Systems Interface 
 

VERICUT connects to the TDM Systems tool management database using a Dynamic 
Link Library (DLL) supplied by TDM Systems. It is mandatory to use the DLL supplied 
with your specific TDM installation since the DLL is both specific to the TDM version 
and to the Oracle database version. 

NOTE:  For VERICUT 7.0 the DLL name has changed. VERICUT 7.0 is 
specifically looking for a DLL named TDMAPI.dll.  

Copy the TDMAPI.dll from your TDM installation into the …\windows\vericut folder 
of your VERICUT installation (for example, C:\cgtech6x\windows\vericut). An optional 
VERICUT license from CGTech is required in order for VERICUT to access tool data 
that resides in the TDM Oracle database. Once the license and DLL are in place 
VERICUT’s TDM Systems Interface can then be envoked from the Tool Manager > 
File menu. 

Creation of VERICUT tool information in the TDM database requires custom 
configuration services from TDM Systems, and an optional license from TDM Systems 
to enable creation of tool data for VERICUT.  

The TDM configuration and installation instructions are part of the TDM install 
documents provided by TDM Systems. 

 

 

Return to Installation Steps. 



 

 

Installing the Model Interface Modules 
 

The Model Interface modules (CATIA V4 Model Interface, CATIA V5 Model Interface, 
STEP Model Interface, and ACIS Model Interface) enable VERICUT to both read and, 
when combined with Model Export, write the designated model file formats. These 
modules do not require a CAD/CAM system be available for VERICUT to read or write 
any of the formats. The modules are available for both Windows 32 bit, and Windows 64 
bit platforms. Each module is licensed separately.  

Once you have completed your VERICUT installation, install the Model Interface files as 
follows: 
 

1. Download http://download.cgtech.com/public/Install_Model_Interfaces_MIR18.zip. 
2. Unzip the contents to expand the Install.exe installation program. 
3. Double click on Install.exe to start the installation process. 
4. During the installation process you will be prompted for the location of your 

VERICUT installation. For example, respond with C:\cgtech70, or wherever you 
have VERICUT installed. The installer will then install the Model Interface files 
in the correct location. It will also, depending on your existing c:\cgtechxx 
installation, either install 32-bit, 64-bit, or both if you have both installed. The 
files will be located in the C:\cgtechxx\windows\spatial and/or 
C:\cgtechxx\windows64\spatial folder(s). Where the xx represents the VERICUT 
release number. For VERICUT 7.0 the xx would be 70. 

5. In addition to installing the interface files the installer also updates acisenv.bat in 
the C:\cgtechxx\windows\commands, and/or C:\cgtechxx\windows64\commands 
folder(s), depending on your installation. 

 
VERICUT’s CAD Model Interface modules should now be available. 
 

If errors occur,  visit the VERICUT Users' Forum or contact CGTech technical support 
via our website, just click on the support link. 

 
Return to Installation Steps. 

 

http://download.cgtech.com/public/Install_Model_Interfaces_MIR18.zip
http://cgtech.com/forum/
http://cgtech.com/
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